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About OmniUpdate, Inc.
OmniUpdate® is the leading web content management system (CMS) provider for higher education. The
company focuses on providing an exceptional product and customer experience to its OU Campus™ CMS
users who manage more than 700 web and mobile sites in the U.S. and around the world. OU Campus is
secure and scalable, server and platform independent, and seamlessly integrates with other enterprise campus
systems. It provides college and university web developers, administrators, and marketers with the user-
friendly tools and deployment flexibility they need to achieve excellence. For more information, visit .

About This Guide
The End-User Reference Guide provides information about using OU Campus including how to get started with
editing, reviewing, and publishing pages and other content.

OU Campus Support
The Support site is available to everyone and users are encouraged to visit and browse the site for information.
An institution's administrators are also available if the answer cannot be found on the Support site or further
explanation and clarification is needed. Administrators may contact the OmniUpdate Support Team. Ways to
access the OU Campus support documentation include:

• Support site: http://support.omniupdate.com/
• The help link in the main interface of OU Campus
• The WYSIWYG Help link
• Help links embedded in the system
• Text instructions are provide onscreen for specific fields and functionality
• OmniUpdate Community Network (OCN): http://ocn.omniupdate.com/

Conventions
Shorthand for navigation through the OU Campus CMS is indicated with a greater-than sign and bolded: > For
example, Setup > Sites. Code snippets use Courier New and a shaded background.

http://support.omniupdate.com
http://ocn.omniupdate.com/
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End-User Introduction
OU CampusTM provides users an easy way to manage web pages. With the ability to login directly from
the institution’s website, it is easy to navigate to the page to be edited. Once logged in, users can simply
click on the area to edit, and they are placed in a user-friendly What-You-See-Is-What-You-Get (WYSIWYG)
Editor.

The system allows an approval process to be put into place, which results in users either having the ability
to publish pages once they have finished editing them, or they can send the completed pages to other users
as defined by the workflow to gain approval prior to publication. The system has a built-in intelligence that
allows the workflow process to be defined prior to page creation. Users do not have to understand which
pages need approval prior to publication because the system tells them.

Pages are checked out to only one user at a time to prevent users from overwriting each other’s work, but
as the pages move through the workflow system, the system automatically changes to whom the page is
checked out based on its placement in the workflow system. In addition, users can only access content
to which they have permissions to edit. When creating new pages, preconfigured templates are made
available to provide consistency in web page design. Users may also have the ability to upload new images,
add words to the OU Campus dictionary, access full page source, and much more.

OU Campus Support
Online support is available through the OmniUpdate Support site at:

http://support.omniupdate.com/oucampus10/

The Support site, which is accessible by everyone in its entirety, includes user support on all the features
in OU Campus, as well as video and text tutorials, archived Training Tuesdays, which are the free monthly
webinars offered the last Tuesday of every month unless otherwise announced at 11:00 AM PST, and
access to the Permissions Chart.

The Support site can be accessed through the Help link in the upper, right-hand corner of OU Campus.
Additionally, support can be gained using the contextual help links found within OU Campus. Throughout
the site the in-context help links are available and are specific to the area or task at hand. These links open
the relevant page at the Support site.

Finally, contextual help may also be found within the CMS as instructions relating to particular fields.

http://support.omniupdate.com/oucampus10/
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The Support site is available to everyone. Users are encouraged to visit and search the Support site. The
institution’s administrators are also available if the answer cannot be found on the Support site or further
explanation and clarification is needed. Administrators may contact the OmniUpdate Support Team.

Filter and Quick Search
The Filter tool is available on the Pages list view and many views within the content management system.
The Filter tool allows the content listed on the screen to be delimited by the string typed into the Filter field.
The filter applies to specific columns that are available on the the screen and usually the filter does not
apply to the date column.

If the Quick Search functionality is turned on, it is possible to search the entire site for content. This search
allows the user to find content in order to easily navigate to a desired page.

On the Pages list view the Quick Search is also the Filter tool. Content in the current view is filter; pressing
Enter uses the Quick Search functionality to search the entire site.

Advanced Search allows for additional search criteria to be applied. The search can be narrowed by:

• Content (the search term)
• Path
• Title
• Description
• Keywords
• Other Meta
• Limited in scope to current folder and below
• Limited in scope to only pages to which the user has access
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Keep in mind that the Quick Search does not search through code and it is not a find and replace function.
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Log In
Logging In Overview
Content contributors and administrators alike can log in to OU Campus through a published page with the

use of an on-page link known as DirectEditTM. DirectEdit can be a link or a button as it can be styled to
match the styling of the site, or it can be an image or a date stamp anywhere on a published page. Typically,
every page of a web site includes a DirectEdit link to allow content contributors to log in directly to edit a
page.

Users are logged in directly to the edit view of the page rather than having to navigate a file structure to
locate a particular page or file. However, pages and files can be accessed in either fashion. In both cases,
users must have the proper access privileges granted in order to access the page. When using the folder
structure to navigate, users must have access to the directories leading to the page to be edited in order to
traverse through the structure.

The DirectEdit button type is configurable for the site by a Level 10 administrator. At the account level, the
Login Page settings can be used to configure log in, log out, and authentication pages.

The layout that is viewed upon logging in to OU Campus depends upon the access settings for that
particular editable region.

About DirectEdit
Initial access is granted from the institution’s main website by navigating to the page to be edited and
clicking the DirectEdit link. DirectEdit links are determined by the template design. For example, the demo
site, Gallena University, uses the Last Updated date found in the footer of the web pages as the DirectEdit
link.

Once logged in, the browser session is persistent and a user can open another page in the same browser
without having to log in again.

Editing a Page with DirectEdit
1. Click the DirectEdit link on the published page. If a user does not know what has been specified for their
institution, they should contact their administrator.
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2. Use the log in credentials that have been provided by the administrator. This might be a user name and
password that is specific to OU Campus, or it may be another authentication method is being used; such
as, LDAP, CAS, or Shibboleth. In this case, the credentials provided by the account administrator for those
methods are honored by OU Campus.

3. Select an editable region.

4. Edit the page.

5. Save and publish the page (or send to an approver).

Example CAS Log In Page
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Editable Regions
The view when accessing a page directly depends on the type of page or content being accessed. The
page may include many editable regions, just one editable region, or may provide an Asset Chooser or
Image Chooser by which only a specific content type can be selected. For example, the following image
shows three editable regions, each of which the content is edited separately from the other regions. One
Edit button corresponds to the global navigation menu, one to the local navigation, and the other to the main
content of the page.

Selecting an editable region button provides access to edit that area using the WYSIWYG Editor, by default.
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Logging Out
Content contributors and administrators alike can log out from the global navigation bar.

1. Hover over the user’s name.

2. Choose Logout from the menu.

3. The original Login screen is shown unless otherwise configured by an administrator.

Reset Password
Content contributors and administrators alike can create a new password for their account. Reset Password
allows users to change their password via a dialog box by entering their username and email address in the
text fields. After the information has been provided by the user to the system and submitted, an automatic
response email is sent to their inbox. This email contains directions and a link that users can use to reset
their password on their own without having to contact a system administrator.

1. From the main Login screen, choose Reset Password.
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2. The page will refresh, displaying a new dialog box. The user should enter their username and email
address where the link to reset the password will be sent. Once both text fields have been populated
with information, choose Submit. Should either text field be left empty, the user is prompted to fill out the
appropriate field before being allowed to continue. If the operation needs to be cancelled, simply choose
Cancel.

3. After a user has submitted their request, the system notifies them that it has sent an email to their inbox
with instructions and a link to reset their password.
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Failed Logins and User Lockouts
If a user incorrectly enters their login credentials more than three consecutive times, then they will
automatically be locked out of the OU Campus system. This will prevent users from being able to perform
additional login attempts. In the event of a user lockout, the Reset Password function becomes unavailable.
Instead, an administrator must be contacted to reset the user’s privileges.
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Checked Out/In
Checked Out/In Overview
File status indicators reflect the state of an OU Campus page and other files. When a user edits a page by
clicking an edit button, the page is automatically checked out to that user. Likewise, when the user publishes
a page it is automatically checked back in. A user might also manually checked out a page as this makes
other page options available. The file status indicators help make clear why a page is not available for
editing as well as who has checked out a page or scheduled an action. These icons are shown on many of
the screens that display listings of content, as well as the File Navigation sidebar, which is global to a site,
and can be shown in the My Current Pages gadget if so configured.

For example, on the Pages list view (Content > Pages), the page status indicators are found in the flag
column and reflect whether a page is checked out, assigned in an approver workflow, or has a scheduled
action associated with it. As shown in the image below, a lit light bulb indicates a page is checked out to the
currently logged in user and a red lock indicated the page is checked out to another user. The unlit light bulb
indicates the file is checked in and available to check out.

Checking Out a Page
A page may be checked out from the following locations by clicking the unlit light bulb icon:

• Pages list view
• File Navigation sidebar
• Gadgets sidebar > My Current Pages gadget (if enabled)
• Dashboard > My Current Pages dashboard gadget (if enabled)
• Preview and Edit views

Regardless of the method used to check out a page, the status is updated accordingly.

Example of Check Out Icon in Pages List View
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Example of Check Out Icon in Edit View

 

Example of Check Out Icon in File Navigation Sidebar
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Example of Check Out Icon in Gadgets Sidebar

Status Indicators

Icon Description

An unlit light bulb indicates that the page is
checked in and can be checked out for editing by
any user with the proper permissions.

A lit light bulb indicates that the page is checked
out to the current user (the individual currently
logged into, working in, and viewing OU Campus).

A red lock indicates that the page is checked out to
another user. It is possible to hover over the lock to
see to whom the page is checked out.

   A green calendar icon is the status indicator for
a publish scheduled by the current user. The
calendar icon can be clicked on by an administrator
or the individual who scheduled the page to be
published in order to change the publish date and
time, or to cancel the publish completely. 

A red calendar icon is the status indicator for a
publish scheduled by another user. The calendar
icon can be clicked on by an administrator or the
individual who scheduled the page to be published
in order to change the publish date and time, or to
cancel the publish completely. 

   

 

A red circle with a line through it is the status
indicator for an expire scheduled by the current
user or another user. A scheduled expire can
be removed or rescheduled by the user who
scheduled the expire. An administrator can check
in the page which effectively removes the schedule
expire. This icon is displayed to the user who has
scheduled the expiration and all other users. 
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Checking In a Page
It is valuable to note that pages stay checked out to the user until the user:

• Sends the page to another user for review.
• Publishes the page.
• Checks the page back into the system by clicking on the lit (yellow) light bulb.

Behaviors of Checked Out Pages
If a page is checked out by another user, the current user may still perform the following actions; even
though the page is locked:

• Edit access settings
• Edit reminders
• Preview the page
• View the log
• Copy the file

Example of Available Actions

Best Practices
• Make sure to check the page back in when finished editing the page so it can be made available to other

users.

• OU Campus supports WebDAV and can be enabled by a Level 10 administrator. When WebDAV is
enabled, OU Campus supports file locking with specific WebDAV clients that utilize file locking.
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Drag and Drop
Drag and Drop Overview
OU Campus includes the ability to drag and drop content including pages, files, binaries, and directories.
Like with other user interfaces, dragging and dropping objects is accomplished by pointing to the content
object with a mouse (or other device), pressing the mouse button and while holding it down, dragging it from
the local computer to the OU Campus interface or from the OU Campus interface to another location within
the interface, and releasing the mouse button.

This is especially useful for quickly uploading files from a local computer to a server or moving content
within OU Campus. Drag and drop functionality is built into the interface for both the staging and production
servers. Users can utilize the drag and drop functionality of the interface to move, upload, and insert content
using what are referred to as "drop zones."

In addition to image file types, files with extensions of .html, .js, .txt, .xsl, .exe, .asp, .php, and .pcf may also
be dragged to the Pages list view.

The Drop Zone
The drop zone refers to the area within OU Campus where a file or directory can be dropped when dragging
to the interface.

When dragging files to or within OU Campus, a green line encapsulating a content area or green
highlighting of a content row provides a visual indication of the allowed drop zone. When dragging to upload
to OU Campus, a green line encapsulating a content area provides a visual indication of the allowed drop
zone. The blue notification provides an additional indicator of the validity of the drag action.

Dragging content in to a page being edited with the Source Editor results in gray or purple highlighting of the
dropped content.

Moving Content with Drag and Drop
Drag and drop functionality can be used to move files from one location to another within an OU Campus
site. When Dependency Manager is on, content moved on staging, including directories, are silently
republished to the production target and linking is updated automatically; unless, the content is locked with
an action that would otherwise prevent auto-publishing such as a scheduled expire. Content moves on
production, including directories, are not reflected on staging. Content can be moved using the drag and
drop functionality of the interface from the following locations:

• Content can be moved within the Pages list view
• Content can be moved within the File Navigation sidebar
• Content can be moved from the Pages list view to the File Navigation sidebar
• Content can be moved from the File Navigation sidebar to the Pages list view
• Content can be moved from the Gadgets sidebar in to a directory in the Pages list

When moving files within OU Campus, a file with the same name is not allowed to be overwritten; for
example, moving an index.pcf from one directory to another with an index file would result in an error
notification. Users can move files either individually or in bulk using drag and drop. To move files using drag
and drop:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
Alternatively, expand the File Navigation sidebar and navigate to the file using that method.

2. Once the file has been selected, drag the content to its new destination.
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3. To move multiple files, select the checkbox next to each target item and then drag the content to the
new destination folder. The icon displays a number, indicating the number of files being moved.
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Uploading Content with Drag and Drop
Drag and drop functionality can also be used to upload content to a site in OU Campus. When Binary
Management is not enabled, binary files uploaded through staging are uploaded directly to production or the
default publish target. With Binary Management enabled, binary files can be uploaded directly to staging.

Content uploaded to staging must be published or copied to production to be available on the web server.
When dragging content that will takes a lengthy amount of time to complete, a notification is shown upon the
completion of the action even if the user has navigated to another area of the CMS. For more information on
uploading content:

Upload

Inserting Content with Drag and Drop
When a user is in the WYSIWYG Editor or the Source Editor, they are able to utilize drag and drop
functionality to insert content directly onto the page. Content can be inserted in the WYSIWYG Editor using
the Images gadget, and all file types can be inserted using the Insert File Path option. To insert images with
the Images gadget:

1. a. Ensure that the Images gadget is enabled by expanding the Gadgets sidebar and clicking
Choose Gadgets. Select Images from the dialog and click Close.

b. Navigate to the page to be edited and open an editable region to display the WYSIWYG Editor.
c. Expand the Images gadget in the Gadgets sidebar to display the available images.
d. Drag and drop the image into the WYSIWYG Editor.

http://support.omniupdate.com/oucampus10/pages/upload/index.html
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WYSIWYG Editor
WYSIWYG Editor Overview
There are several types of editors available to edit pages in distinctly different ways, but the WYSIWYG
editor is the most common way for users to edit pages in OU Campus. The WYSIWYG (What You See
Is What You Get) Editor allows for a familiar experience of editing a page similar to that of many web
applications and traditional word processors.

When logging into the system to directly edit a page, there may be several editable regions available. The
available editable regions are defined by permissions levels and group associations. Only areas that are
available to be edited by that user are shown with an edit button. Clicking on the Edit button above a region
allow for the area to be edited. This opens the WYSIWYG Editor by default and the assigned toolbar is
available.

Keep in mind that part of the configuration of the template design may include an image
in the background that helps present a more accurate rendering of how the content will appear on the page.
It is intended for visualization purposes and to help understand how the content is organized on the page
into editable regions. Once the content has been saved, an actual view of the configured page can be seen
using the Preview mode.

When editing in the WYSIWYG, modifications should be saved by clicking the Save icon before navigating
away from the page. If an attempt is made to navigate away from the page without first saving it, the user
notification is shown as a reminder to save the page.
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Toolbars and Tools
Many of the editing tasks for a page such as inserting images and links, applying formatting such as bold,
and spell checking a page can be accomplished from within the WYSIWYG using the toolbar. WYSIWYG
toolbars are customizable and the toolbar the user sees may contain a subset of the available tools as
various custom toolbars can be created, which can be assigned to users, sites, directories, pages, and
editable regions.

Icons represent the tools. Clicking on any icon performs an action, either directly to the page, or to the
selected text and graphics. Some icons display more options in a drop-down menu, or in a dialog.

The availability of a function is based on the selected items, or the location of the cursor on the page. For
example, if nothing is selected, functions such as Insert Link are dimmed, signifying that this function is not
available at the moment. For the Insert Link function button to be available, the user must first select text or
a graphic.

In many cases, right-clicking offers contextual functions. For example, right-clicking within a table provides a
list of available table editing and formatting functions. Additionally, commonly used control key combinations
are available such as CTRL+X, CTRL+C, and CTRL+V for cut, copy, and paste respectively for PC.

Toolbar Functionality
Each toolbar is organized into three rows and each row has groups of functionality. In the WYSIWYG, the
groups are divided by a vertical line on-screen. The behavior of the icon is specific to the functionality of
the tool. For example, some functionality such as the link tool requires text or another type of content to be
selected before it is available on the toolbar. Other items on the toolbar include icons that are unavailable
until the main feature has been inserted on a page. For example, the Insert/Edit Table icon will be available,
but the other table editing tools such as those to define row properties or delete a column are not available
until a table has been inserted on a page. Some items such as the Insert/Edit Image icon or spell check,
when clicked, provide a dialog with a much more underlying functionality than is readily apparent. One last
type of element that might be available on the toolbar are several drop-down selectors that provide the
ability to style text. 

One item that is not represented on the toolbar, but is available from within the WYSIWYG is the ability
to save-in-place (CTRL+S or CMD-S). This offers users the ability to save the page without clicking the
usual save icon that ends the editing session. Save-in-place saves the page and allows the user to continue
editing.
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Toolbar Row 1
Toolbar Row 1 Overview
Most of the tools available on the first row of a toolbar for the WYSIWYG are basic text formatting and
linking. The descriptions of the functionality available for each tool is provided on this page. A few of the
features have a more in-depth description; links are provided to those pages.

The tools are grouped on this page as follows:

• Save, Save As, Revert, Restore
• Cut, Copy, Paste, Find, Replace
• Undo/Redo
• Toggle Spell Checker
• Remove Formatting
• Font Formatting
• List, Indents
• Text Placement (Vertical)
• Align, Justify (Horizontal)
• Link Tools, WYSIWYG Help Documentation

File Tools (Save, Save As, Revert, Restore)

Icon Tool Description

Save Click on the Save icon to save
the current file on the staging
server and exit the WYSIWYG
Editor. Remember, it will not be
live on the production server until
it is published. To use save-in-
place, use the keyboard shortcut
CTRL+S for Windows or CMD+S
for Mac.

Save As Click on the Save As icon to
save the current file with a new
file name and exit the WYSIWYG
Editor.

Revert to Last Saved Click on the Revert to Last
Saved icon to undo all changes
and revert the content in the
editable region to its original
state.

Auto Draft Click on the Auto Draft icon to
restore the content to its last
auto-saved point. For more
information:

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/saveinplace.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/saveinplace.html
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Icon Tool Description

Auto Draft

Cut, Copy, Paste, Find, Replace

Icon Tool Description

Cut To remove content from the
document, highlight the content
and click the Cut icon. The
keyboard shortcut is CTRL+X for
Windows or CMD-X for Mac.

Both Mozilla Firefox and Safari
disable the use of this feature. To
Cut using one of those browsers,
use the keyboard shortcuts. To
learn how to enable the use of
this feature in Firefox, see:

Turning on Cut/Copy/Paste in the
Firefox Browser

Keep in mind that this requires
the ability to modify a script and
is not a checkbox.

Copy To copy a content from the page,
highlight the content and click
the Copy icon. The keyboard
shortcut is CTRL+C for Windows
or CMD-C for Mac.

Both Mozilla Firefox and Safari
disable the use of this feature.
To copy using Firefox or Safari,
use the keyboard shortcuts. To
learn how to enable the use of
this feature in Firefox, see:

Turning on Cut/Copy/Paste in the
Firefox Browser

Keep in mind that this requires
the ability to modify a script and
is not a checkbox.

Paste To paste content on to a page,
click the location the content
should be placed on the page
and click the Paste icon. The
keyboard shortcut is CTRL+V for
Windows or CMD-V for Mac.

http://support.omniupdate.com/oucampus9/content/wysiwyg/autodraft.html
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
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Icon Tool Description

This pastes only valid content,
code, and styling. The paste
automatically switches between
a traditional paste (e.g., pasting
the code when text is copied
from a page in a web browser),
and pasting from Word, removes
the MSO formatting that is not
appropriate for a web site, as
needed. The Paste function
always cleans up the content
to be pasted to remove any
formatting or code that is not
compliant with the requirements
of the WYSIWYG Editor.

Both Mozilla Firefox and Safari
disable the use of this feature.
To paste using one of those
browsers, use the keyboard
shortcuts. To learn how to enable
the use of this feature in Firefox,
see:

Turning on Cut/Copy/Paste in the
Firefox Browser

Keep in mind that this requires
the ability to modify a script and
is not a checkbox.

Paste as Plain Text To paste as plain text, click
the Paste as Plain Text icon.
The icon stays selected until
clicked again, and all pastes
going forward until exiting the
WYSIWYG Editor will be plain
text. This removes all formatting.

Both Mozilla Firefox and Safari
disable the use of this tool.
To paste using one of those
browsers, use the keyboard
shortcuts. 

To learn how to enable the use
of this feature in Firefox, see:

Turning on Cut/Copy/Paste in the
Firefox Browser

http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
http://support.omniupdate.comhttps://developer.mozilla.org/en-US/docs/Midas/Security_preferences
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Icon Tool Description

Keep in mind that this requires
the ability to modify a script and
is not a checkbox.

Find Click the Find icon to search for
text on the current page.

Find/Replace Click the Find/Replace icon to
search for text on the current
page then replace that text with
other text.

Undo Redo Functions

Icon Tool Description

Undo Click the Undo icon to undo
the last changes made in this
session one by one.

Redo Click on the Redo icon to redo
changes that were previously
undone and should be restored.

Spell Check

Icon Tool Description

Toggle Spell Checker To spell check the region that
is being edited, click the Toggle
Spell Checker tool. Misspelled
words are underlined with a
red, squiggly line. Change the
incorrectly spelled word with the
suggested words provided or
choose one of the other options
provided:

• Ignore the incorrectly spelled
word (e.g., not make any
changes to it).

• Add to the word to the
dictionary: Level 9 and 10
administrators can add
marked words to a site-wide
dictionary, and administrators
can give users Levels 1
through Level 9 the ability to
add words to the dictionary
as well.
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Icon Tool Description

Learn more about the spell
checking.

Remove Formatting

Icon Tool Description

Remove Formatting To remove all formatting for a
selection, highlight the text to be
updated and click the Remove
Formatting icon. This returns the
selected text back to the default
settings.

Font Formatting

Icon Tool Description

Bold Applies bold formatting to
selected text.

Italic Applies italicized formatting to
selected text.

Underline Applies
underlined

formatting to selected text.

Please note that underlined text
usually means that a word or
phrase is a link to another web
page. In this case however, the
underline formatting does not
create a link (to create a link,
click Insert/Edit Link).

Strikethrough Applies
strikethrough

formatting to selected text.

Lists, Indents

Icon Tool Description

Unordered list Turns the selected text into an
bulleted list. Example:

• Apples
• Oranges
• Bananas

http://support.omniupdate.com/oucampus9/content/wysiwyg/spellcheck-dictionary.html
http://support.omniupdate.com/oucampus9/content/wysiwyg/spellcheck-dictionary.html
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Icon Tool Description

Ordered list Turns the selected text into a
numbered list. Example:

1. Click the Go button.
2. Enter the text to search on.
3. Click Start.

Outdent To decrease the indent of a
paragraph, click the Outdent tool.
Each consecutive click moves
text further to the left.

Indent To increase the indent of a
paragraph, click the Indent icon.
Each consecutive click moves
text further to the right.

Blockquote Blockquote is a block-level
element in HTML that can be
used to set-off quotations or to
cite material.

Text Placement (Vertical)

Icon Tool Description

Superscript Formats the selected text as
superscript text.

Subscript Formats the selected text as
subscript text.

Align, Justify (Horizontal)

Icon Tool Description

Align Left Aligns a block-level element such
as a paragraph or a heading to
the left margin.

Align Center Center aligns a block-level
element such as a paragraph or
a heading within the left and right
margin.

Align Right Aligns a block-level element such
as a paragraph or a heading to
the right margin.

Align Full Justifies text making it flush on
both the left and right side
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Link Tools, WYSIWYG Help Documentation

Icon Tool Description

Insert/Edit Link To create a hyperlink:

1. Select the text or image for the
link.

2. Click the Insert/Edit Link tool.
If applicable, the dialog contains
existing link information.

3. Click the Browse icon to select
an internal page to which to link.

4. After locating the file, click
Select Link.

5. Click Insert.

For links to pages internally, a
page should generally be chosen
from a production server, publish
target, or an auxiliary server.  An
unpublished file on the staging
server or publish target can
also be chosen by choosing the
staging server or publish target
from the drop-down, navigating
to the file, and selecting the
HTML version that is available.
Links can also be made across
sites within an account with the
file browser by clicking Sites in
the breadcrumb and choosing
the appropriate site.

For links external to the site, the
complete URL for the resource
can be typed (or pasted) into the
URL field. Optionally, a target
window type and an anchor
name can also be entered.

For more information about links
and linking:

Insert/Edit Link
If Dependency Manager has
been enabled for the account,
dependency tags instead of
URLs are inserted into the

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/index.html
http://support.omniupdate.com/oucampus9/content/dependency-manager.html
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Icon Tool Description

source of the page when
inserting a link.

Create or Modify a Mailto Link To create a mailto link, select
the text or image for the link,
then click the Create or Modify a
Mailto Link icon. If applicable, the
resulting dialog contains existing
mailto information. Properties
for the mailto link can be defined
including the email address
that is provided when the link is
clicked. For more information:

Mailto Link

Unlink Select in the hyperlink and click
the Unlink icon to remove a
hyperlink.

Note

: For unlinking anchors, the
Unlink icon works with anchors in
Internet Explorer. It will not work
on anchors in Firefox, Safari, or
Chrome.

Insert/Edit Anchor To create an anchor:

1. Position the cursor where
the anchor should be placed or
select the text or image.

2. Click the Insert/Edit Anchor
icon.

3. In the Anchor Name field,
enter the name for the anchor.
It is not necessary to enter a #
(hash mark).

4. Click Insert.

To modify an existing anchor:

1. Click the existing anchor
shown in the editing area.

2. Click the Anchor icon on the
toolbar.
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Icon Tool Description

3. The Insert/Edit Anchor dialog
shows the existing text for the
anchor.

4. Make the modification to the
text and click Update.

The specifics of valid anchor
names can be found in the HTML
specifications:

HTML 4.01

HTML 5

Help Icon The Help icon displays the help
text for the WYSIWYG Editor. It
show help text for all available
functions, not only those limited
to the toolbar being used.

http://www.w3.org/TR/html401/struct/links.html
http://www.w3.org/TR/html5-diff/
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WYSIWYG Spell Check
WYSIWYG Spell Check Overview
Within the OU Campus™ WYSIWYG Editor there is a built in spell checker. Provided that this feature is
available in the selected toolbar being used, utilizing the spell checker before publishing a page helps
increase the professionalism of the site. Currently the spell checker supports five languages, each with
its own custom dictionary. The current languages supported are: English, Spanish, French, Italian, and
Portuguese. These are the same custom dictionaries that are used during Page Check and/or Final
Check. The WYSIWYG Spell Check feature checks the spelling for the editable region that is open in the
WYSIWYG. This differs from the Page Check/Final Check spell check, which performs the spell check on
the complete page prior to being published.

New and custom words can be added to the spell check dictionary on a per site basis. This is a useful
tool for organizations with a set of custom words they do not want to appear marked as misspelled when
using spell check in the WYSIWYG Editor. Custom words that have been added to a site’s dictionary are
omitted by the spell checker tool in the WYSIWYG Editor for any page within that site. Keep in mind that it
is possible that the spell checker in an individual#s browser may still mark the word as misspelled. If a word
has been added to the dictionary, and it is still being marked as misspelled, check the browser's spell check
settings.

The default language is a configuration option, which allows various pages or users to be able to be able
to use by default different language options. The different custom dictionary can be selected from the drop-
down menu.

Once the WYSIWYG Spell Check is toggled on, misspelled words stay highlighted until an action is
performed that corrects the issue. If new words are typed and misspelled, the spell check should be run
again to catch more words.

Correcting Misspelled Words
1. Click the Spell Check icon from the WYSIWYG Editor toolbar. The default language will be used to spell
check the page. However, if the page should be edited in another language click the downward facing arrow
portion of the split button and select another language.

Misspelled words are identified with a wavy, red underline.

2. Click on a word identified as misspelled. This displays a list of words that may be selected to replace the
misspelled word and other options.
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3. Select one of the suggested words or, one of the other options.

Other options are:

• Add to dictionary (if access has been granted)
• Ignore word: Allows just the current instance of the word to not be marked as misspelled
• Ignore all: Allows all current instance of the word to not be marked as misspelled

Note

: Keep in mind that the browser’s spell checker may be active and marking
words as misspelled while the page is being edited. However, only OU Campus’ spell checker references
the OU Campus custom dictionary. To help verify that a word is being marked as misspelled by the OU
Campus dictionary, look to see if the
spell check icon is highlighted. This indicates that the OU Campus spell checker is being used.

Adding Words
Adding custom words to the spell check dictionary is available dependent upon authority level. It is included
automatically for Level 9 and 10 and it can be made available to Level 1 and above users by a Level 10
administrator.

1. Click the Spell Check icon from the WYSIWYG Editor toolbar.

2. Click the misspelled word that should be added.

3. From the shortcut menu, choose Add to dictionary.

When adding new words to the custom dictionary, they will get added to the dictionary of the language that
is set for the spell checker tool. Unless set differently by an administrator, the default language is English.
An additional custom dictionary may exist at the account level.



OU Campus WYSIWYG Spell Check Page 37 of 188

Browser Specific Spell Check vs. OU Campus Spell Check
In the WYSIWYG Editor misspelled words can still appear underlined in red (indicating a misspelled word),
even after they’ve been added to the dictionary. The reason for this is that many modern browsers have
spell-as-you-type or automatic spell-checking capabilities built-in. This can lead to some confusion as to
whether or not a word has in fact been added to the dictionary. To eliminate this problem it can be helpful to
turn off the browser#s spell-as-you-type functionality.

Refer to the specific browser help documentation on spell check for Firefox and Google Chrome. Safari also
has a built in spell checker. Internet Explorer requires an add-on. Keep in mind that this is not all-inclusive of
all available browsers, platforms, add-ons, or applications for spell checker options. Should the information
needed not be listed in this help document, please see the help documentation for the browser, add-on, or
application being used.

Disabling Automatic Spell Checking in Firefox
By default, Firefox is configured to automatically check spelling. It can be turned off in the Preferences
window:

1. At the top Firefox menu bar, click the Tools > Options on Windows or Firefox > Preferences on a
Mac.

2. Select the Advanced panel.
3. Click the General tab.
4. Clear the checkbox labeled Check my spelling as I type.
5. Click Okay or exit the Preferences window to save the changes.

http://support.mozilla.org/en-US/kb/how-do-i-use-firefox-spell-checker
http://support.google.com/chrome/bin/answer.py?hl=en&answer=95604
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Disabling Automatic Spell Checking in Safari
By default, Safari is configured to automatically check spelling. Turn it off on the Edit menu:

1. At the top Safari menu bar, click Edit.
2. Click Spelling and Grammar.
3. Click Check Spelling While Typing. If a checkmark is present, spell check is enabled for Safari. If a

checkmark is not present, spell check is disabled for Safari.
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Insert/Edit Link
Insert/Edit Link Overview
The Insert/Edit Link tool provides the basic functionality to add a hyperlink within the WYSIWYG Editor.
Links are created by highlighting text or an image, clicking the Insert/Edit Link icon, and specifying the
Link URL. The Insert/Edit Link icon is dimmed until the text or image to be hyperlinked is selected. Links
can point to internal web links, external websites not maintained in OU Campus, or other pages within
OU Campus. The Insert/Edit Link icon can also be used to create links to files, such as PDFs. In addition
to providing the basic functionality for creating and maintaining links, this tools provides more advanced
functionality relating to linking including linking to anchors, specifying targets, applying classes, and utilizing
JavaScript and HTML to affect the style and behavior of a link. Several tutorials are included on this page:

• Inserting an Internal Link (Typical)
• Linking to an Unpublished File
• Linking Across Sites within an Account
• Inserting a Link to an External Site
• Specifying a Target

Links and Dependency Manager
It is possible for links to pages or directories maintained within OU Campus to be updated automatically
when the page or directory to where the link is pointed is moved or renamed. The links are tracked
by Dependency Manager. When Dependency Manager is activated, it is important to browse for the
appropriate page in order to ensure that the link will be updated if the target page, directory, or other content
is moved or renamed. Pages can also be linked to internally without browsing and inserting a dependency
tag, and can also be specified with a root-relative syntax.

Dependency Manager can be configured to manage links both within a site and across sites within an
OU Campus account. However, it does not manage links to external websites such as CNN. If Binary
Management is in use for the site or sites, binary files such as PDFs and images are also managed.

Links with dependency tags may also be inserted with the Source Editor and file choosers and are
supported across publish targets if Multi-Target Publish is configured. Once the appropriate page is
selected, a dependency tag is shown instead of the page path. The actual path to which the link will be
pointed is shown below the Dependency tag.

Example syntax for the tags are shown as follows:

• {{d:####}} — Directory tag
• {{f:####}} — File/Page tag
• {{a:####}} — Asset tag
• {{s:####}} — S-tag
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Example of a Dependency Tag

Inserting an Internal Link (Typical)
1. Within the WYSIWYG Editor, select the text or image for the link.

 

2. From the toolbar, click the Insert/Edit Link tool.

The Insert/Edit Link dialog > General tab is shown. If applicable, the dialog contains existing link
information.
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3. Click the Browse icon to select an internal page to which to link.

The Insert File Link modal is shown.
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4. Select a file to which to link. For links to pages internally, a page should generally be chosen from the
production server, publish target, or an auxiliary server. The production server is selected by default;
otherwise select a different target or server from the drop-down.

• To manually enter a path, click the Elipsis button, enter the path, and press Enter.
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• To upload a file and link to it, click Upload and either Add Files or drag files from the local computer.

4. After locating the file, click Insert. Other configuration options for a link are also available before inserting
the link; for example, entering a Title or selecting a Target window/tab for the link to open in. The Title is
both valuable and important as this is used by screen readers and helps keep the site in compliance with
accessibility compliance standards. The text entered in this field is used to create the title attribute for the
<a>

element in HTML. A developer might use this attribute to display the text when mousing over the link. Here’s
what it looks like in HTML:

<a title="Contact Us" href="{{f:####}}">test</a>

5. Click Insert.

http://support.omniupdate.com/oucampus10/pages/upload/index.html
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Linking to an External Page
The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical) heading, but
rather than browsing for the internal link the complete URL for the resource can be typed (or pasted) into the
URL field. Links to external pages are not under Dependency Manager tracking.

Linking to an Unpublished File
An unpublished file on the staging server or publish target can also be linked to prior to actually publishing
the page. The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical)
heading, but rather than selecting from production a selection from staging is made.

1. Select the text or image for the link.

2. Click the Insert/Edit Link tool.

3. From the Insert/Edit Link dialog > General tab, click the Browse icon.

4. From the Insert File Link dialog, select Staging and navigate to the file.

5. Select the PCF version of the file on staging.

6. From the Select Product modal, choose the HTML version and click Insert Link.
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7. Click Insert.

Linking Across Sites within an Account
Links can also be made across sites within an account when inserting a link on a page within the
WYSIWYG. The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical)
heading, but rather than selecting from production select Sites in the breadcrumb and then choose the
appropriate site.

Specifying a Link Target
The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical) heading, but the
target is chosen from the Target drop-down on the General tab.

As a general rule, when inserting a link to another page on the institution’s website, the link should open
in the same window. When inserting a link to a page outside the institution’s website, or to a PDF, or other
similar file, the page should open in a new window. This options for the Target field include:

• Open in This Window/Frame: Linking to pages on the institution’s website
• Open in New Window (_blank): Linking to pages on another site or binary files
• Open in a Parent Window/Frame (_parent): Used with framesets
• Open in Top Frame (Replaces All Frames) (_top): Opens a page in the topmost parent frame

More Options with Insert/Edit Link Tool
For more information about the additional functionality available on the other tabs, see:

• Links: General Tab
• Insert/Edit Link Popup Tab
• Insert/Edit Link: Events Tab
• Insert/Edit Link: Advanced Tab

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/link-general.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/link-popup.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/link-events.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/link-advanced.html
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Renaming or Moving a Directory or File
Dependency Manager maintains the correct link association when files or directories are moved or
renamed. All the files that link to a moved or renamed file or directory are automatically republished to
maintain the correct link.

When a file or directory is either moved or renamed, a prompt that all dependent pages will be republished
will appear. This will republish the page based on the current version of the page on the live production
server with the new dependency links. If changes have been made but not published to the live site, those
changes will still not be published to the live production server but will be available in OU Campus and still
saved on the staging server. This includes backed up versions.

Broken Links
If content is deleted, a broken link is created. The system has various indications for  broken links.
Dependency Manager provides informative reporting for broken links and broken assets. When a
dependency is lost; for example, a linked-to page or a subscribed-to asset is deleted, the dependency tag,
path, and file name are shown within asterisks. For example:

*** Broken f:1234 /training/about/filename.html***

One way to avoid broken links is to utilize the Include Unpublished Dependencies checkbox from the publish
dialog to publish any unpublished content. Dependency Manager reports at page publish time if there is
dependent content that has not been published to the target server. This includes content that is linked or
referred to by the page that is being published, as well as any unpublished assets. By selecting to include
the unpublished dependencies, those unpublished files are published as well. This action prevents broken
links (for example) from existing on the current page being published.
This checkbox is only shown if the Dependency Manager is being used on the site, dependency tags are
used in the page being published, and one or more of those dependency tags refer to files that have not
been published to the target yet.

Final Notes and Reminders
Dependency Manager links are case sensitive. As such, it is advised that paths for links to pages managed
in OU Campus are always inserted using the browse functionality.

Dependency Manager inserts Dependency tags into <a> and <link> tags at the “href” attribute automatically,
both when the Dependency Manager Scanner is run and when new links are created. However, tags can be
manually included elsewhere as desired.
Dependency Manager will not automatically add Dependency tags to any other types of tags, including php,
asp, and JavaScript.
Important Exception: Dependency tags cannot be placed within processing instructions or the prologue,
which is the instructions prior to the opening XML comment. Entering in Dependency tags within these will
cause an error as they will not be able to be rendered.

Dependency Manager renders root relative links (i.e. /directory/page) or absolute links (i.e.
http:www.college.edu/directory/page), depending on the site settings. The rendered URL to the Production
Site cannot and will not be page relative (i.e., ../page).

Reporting is available with details on which Dependency tags refer to which pages, and which pages are
currently subscribing to those pages.
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Toolbar Row 2
Toolbar Row 2 Overview
A brief description of the functionality available with each tool on row 2 of the toolbar is provided in the
tables below. Several of the features require a more in-depth description and links to those pages are
provided also. Content on this page includes:

• Font Properties (Family, Size, Format, Styles)
• Text Color, Text Background
• Images/Media
• Miscellaneous Functionality

The Font Properties drop-downs and the selectors for text color and background color can be toggled on
and off. For example, if the Format drop-down was used to apply Heading 1, the use of Heading 1 can be
deactivated by deselecting it in the drop-down. Formatting applied with the use of the Styles drop-down,
and those for selecting text color and background color can also be cleared with the use of the Remove
Formatting tool, which is represented by the Eraser icon on the toolbar. In other words, if a span has been
applied, it can be removed by locating the cursor within the span and clicking the Remove Formatting tool. It
is not necessary to be in code view to perform this action.

Font Properties (Family, Size, Format, Styles)

Icon Tool Description

Font Family This Font Family drop-down
displays a list of the standard
fonts recognized by most web
browsers. To change the font
of existing text, select the text
and choose a font from the drop-
down list. To start typing new
text with a specific font, position
the cursor where text where
the text should be inserted and
select a font from the drop-
down list, then begin typing. Text
can also be selected and the
formatting applied. Note that the
appearance in the WYSIWYG
Editor may not reflect the newly
applied styling. From the drop-
down deselect the font size to
stop applying it in the WYSIWYG
by clicking on it again. The
markup is added as a span; for
example:

<span style="font-
family: 'book antiqua',
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palatino;">on the bright
plume</span>

Font Size This Font Size drop-down
changes the size of selected
text. Font size properties are
configured by an administrator
and labeled 1 through 7. To start
typing new text with a specific
font size, position the cursor
where text is to be inserted,
select a size from the drop-
down list, then begin typing.
From the drop-down deselect
the font size to stop applying it in
the WYSIWYG by clicking on it
again. The markup is added as a
span; for example:

<span style="font-size:
x-large;">&nbsp;This
is a font size
application.</span>

Format The Format drop-down lists built-
in styles that can be applied to a
selected paragraph. To apply an
element from the Format drop-
down, click within the paragraph
(or select text), and then click the
element from the drop-down. For
more information:

Format Drop-Down

Styles This drop-down sets the style
of any selected text. The styles
available are configured by the
system administrator. Note that
when applying a class from
a Styles drop-down and then
selecting another class from
the Styles drop-down that both
styles are applied to the text. For
example:

<span class="compare
note">This paragraph has
two classes applied.</
span>

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/format-dropdown.html
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Text Color, Text Background

Icon Tool Description

Select Text Color The color for selected text may
be selected by using a picker,
using a hexadecimal, chosen
from a palette, or by color name.
Alternatively, if a custom color
has already been selected, click
the icon to apply the text color.
There are 216 color choices on
the palette. To start typing new
text with a specific font color,
position the cursor at the location
where new text is to be inserted,
choose a color by clicking on it,
or by clicking More Colors and
using the color slider, palette,
name selector, or by typing in
the hexadecimal color code
preceded by a number sign, and
then begin typing.

Select Background Color The color for the background
of the selected text may be
selected by using a picker, using
a hexadecimal, chosen from
a palette, or by color name.
Alternatively, if a custom color
has already been chosen,
clicking on the icon applies the
choice. There are 216 color
choices on the palette. To start
typing new text with a specific
font color, click the cursor at the
location where new text is to
be inserted, choose a color by
clicking on it, or by clicking More
Colors and using the color slider,
palette, name selector, or by
typing in the hexadecimal color
code preceded by a number
sign, and then begin typing.

Images/Media

Icon Tool Description

Insert/Edit Image The Insert/Edit Image tool
provides the functionality for
linking to an image by browsing
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or by uploading, and allows
for access to the Image Editor.
Additional tabs and fields provide
advanced options for images
such as including styling and
JavaScript. It also includes a
preview. For more information:

Image Editor
Insert/Edit Image

Insert/Edit Embedded Media The Insert/Edit Embedded Media
tool
provides the functionality for
embedding media specific to
several format types to an image
by browsing or by uploading.
Additional tabs and fields provide
advanced options for embedded
media such as specifying
dimensions, setting audio quality
options and Flash options, and
previewing the source. For more
information:

Insert/Edit Embedded Media

Miscellaneous Functionality

Icon Tool Description

Insert Horizontal Line Adds a horizontal rule.

<hr />

Insert line break To insert a line break, click the
Line break icon. This is the same
as entering <br /> into the
source.

Insert Special Character To insert a special character
such as an copyright symbol,
registered trademark, or other
symbol, click the Insert Special
Character icon. The Select
Special Character dialog
provides a selection of 200
special character from which
to choose. Hover or use left
and right keyboard arrows to
navigate the selection. During

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-media/index.html


OU Campus Toolbar Row 2 Page 52 of 188

Icon Tool Description

the selection process, a preview
of the character is shown with its
name, HTML
character

 reference, and numerical

character

entity

reference.

Click on the icon of the character
to insert into the page. Right
click the symbol and choose
Copy Link from the shortcut
menu, to copy to the clipboard,
which allows the symbol to be
repeatedly pasted on a page.

Cleanup Messy Code The Cleanup Messy Code icon
removes extraneous tags and
adds appropriate ending tags
where necessary. This helps with
cross-browser functionality as
well as being a best practice.

 Show/Hide Block Elements Toggles the WYSWISYG view to
show or hide block-level element
labeling. Each element such
as <p> or <article> is displayed
encapsulated with a thin border
and labeled with a small tag. For
more information:

Show/Hide Block Elements

 Show/Hide Guidelines/Invisible
Elements

The Toggle Guidelines/Invisible
Elements icon adds/removes
the outlines of tables and other
elements, for visual purposes
only.

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/show-elements.html
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Edit HTML Source The Edit HTML Source icon
opens a code view of the HTML
source. If a user has been
granted access, there is also an
HTML Source Editor available
for the source code editing. For
more information, see:

HTML Source Editor

CodeProtect Displays the position of server-
side code within the WYSIWYG
Editor represented within the
editing area with the PHP
Symbols icon:

This allows for easy editing of
server side code (PHP only).

Snippets Click the Snippets icon in
order to select preexisting
snippets of HTML or text to
be inserted into the page. The
Snippets available are set by the
system administrator. For more
information:

Snippets

Assets Click the Assets icon in order to
select a preconfigured asset to
insert into the page. For more
information about assets:

Assets

http://support.omniupdate.com/oucampus10/pages/edit/source-editor.html
http://support.omniupdate.com/oucampus10/reusable-content/snippets/index.html
http://support.omniupdate.com/oucampus10/reusable-content/assets/index.html
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Insert/Edit Image
Insert/Edit Image Overview
The Insert/Edit Image tool is available on the default toolbar for the WYSIWYG Editor. Custom toolbars
can be created and assigned to a user or content region utilizing the OU Campus CMS administrator
functionality; and if so utilized, the Insert/Edit Image tool may not be shown on the toolbar.

The Insert/Edit Image tool provides access to a plenitude of functionality related to images, image
management, and code markup for images. At the very simplest, it can be used to link to an image and
provide a description for it, which is usually required. On the other hand, Insert/Edit Image can also be used
to:

• Upload and use the Image Editor
• Manually enter a URL of an image to link to
• Browse to an image that was previously uploaded to link to it
• Provide meta data about an image in the form of an Image Description (alt tag) and Title (title tag)
• Preview an image
• Align an image
• Add space or a border around an image
• Assign a CSS class or styling to an image
• Create an image swap with JavaScript
• Specify an image map

When using the Insert/Edit Image tool, once an image has been selected for insertion on a page, the
WYSIWYG Editor seamlessly provides the HTML mark-up for the link behind the scenes. Users of a certain
user level or with the appropriate permissions can view the markup of a page by utilizing the Source Editor
or Edit HTML Source tool, but is not necessary.

In addition adding an image link to a page, the Insert/Edit Image tool includes  Appearance and Advanced
tabs, which provide content contributors with the ability to further manipulate images by entering information
in a field or selecting it from a drop-down. The Appearance tab provides the ability to modify the appearance
of the inserted image with CSS, but without having to know CSS or directly interface with CSS syntax. The
Advanced tab, in a fashion similar to the Appearance tab, provides miscellaneous functionality for image
manipulation with JavaScript and HTML, including the ability to swap images on mouse over, designate an
image map, and add an ID to the IMG tag. For more information:

Appearance Tab

Advanced Tab

Inserting an Image
1. To insert an image, click the Insert/Edit Image icon.

This shows the Insert/Edit Image dialog.

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-appearance.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-advanced.html
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2. Click the Browse icon to browse to the image.

 

The Insert Image modal is shown. Expanding a folder displays thumbnail images to preview.
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3. Several navigation avenues are available for selecting an image:

• Choose an alternative publish target, or the staging server if Binary Management is in affect, and browse
to the location

• Click the Ellipsis button and manually enter a path
• Expand a directory and click an available thumbnail image preview
• Upload an image

4. Once the image has been selected, click Insert. 

5. From the Insert/Edit Image dialog, enter a value for the Image Description field.

6. Click Insert. The image is shown in the context of the page within the WYSIWYG Editor.
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Editing an Inserted Image
The details of the image can be modified after insertion on a page by clicking the same Insert/Edit Image
icon, making the necessary edits, and clicking Update.

Uploading an Image from the WYSIWYG
A file can be uploaded by browsing the local computer or by dragging to the dialog. Both methods allow for
selecting multiple files for upload at one time.

Dragging a File to Upload

1. As described above, click the Insert/Edit Image tool, and the Browse icon.
2. From the Insert Image dialog, click Upload.
3. Drag the file or files to upload from the local computer to the dialog. (Multiple files may be selected and

uploaded at one time. On a PC, use Control+Click, Shift+Click, or click and drag to select multiple files.
For a Mac, use the Command key to select multiple files.)
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4. Alternatively, click the Add Files button to browse and select local files.

5. If necessary and available, chose an Access Group for the files. This will limit the ability to access the
image to insert it on a page from within the WYSIWYG to members of the group.

6. The ability to overwrite files may be enabled and available by clicking the Overwrite checkbox.
7. Files may be renamed at this point by clicking Rename, entering the new file name, and clicking OK.

Note that after renaming a file, the modification can be reverted by clicking Revert.
8. Click Start Upload to upload the files. 

During the upload the status is shown as In Progress, and when completed, as Done. If a file could not
be uploaded, which may be the case if it does not follow file naming conventions configured by the site,
the status message indicates an error and the file is not uploaded.

9. Click Close when finished.
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Example of Successful File Upload

Additional Information and Reminders
• The ability to upload files is available for users with permission level of 6 or above. Users with permission

level 8 or above have the authority to overwrite an existing file.
• Lower level users (1–5) can be granted the rights to upload through the folder structure in the user’s

settings. This permission includes Zip Import.
• To import multiple files using only one selection and containing subfolders, use the Zip Import feature.
• Zip Import is available to users Levels 6–8 through the user’s settings.
• Note: All binary files (images, documents, PDFs) are uploaded directly to the target production server.

All editable files (HTML and text) are uploaded initially to the OU Campus staging server and must
adhere to any approval process prior to being published to the target production server. Select the
appropriate view of staging server or production server in Pages to confirm that files have been uploaded
properly.

Decorative Images
Decorative images are images for which no <alt> descriptive image tag is required. Inserting decorative
images must be enabled for each site by an administrator. This can be accomplished from Setup > Sites >
WYSIWYG Editor > Decorative Images. The default, Disabled, means that the Decorative Image checkbox
is not available and that an Image Description must be added. For more information:

Setup Sites > WYSIWYG Editor Panel

Using Decorative Images

Once enabled, the Insert/Edit Image dialog in the WYSIWYG editor allows users to select a checkbox
indicating that the image to be inserted is a decorative image and to omit the image description.

http://support.omniupdate.com/oucampus10/pages/upload/zip-import.html
http://support.omniupdate.com/oucampus10/pages/upload/zip-import.html
http://support.omniupdate.com/oucampus10/setup/sites/site-settings/wysiwyg-editor.html
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Image Editor
Image Editor Overview
The Image Editor allows images to be resized, cropped, rotated, and resized with zoom directly in the OU
Campus system. Images can be uploaded and edited all in one operation. The ability to edit an image helps
ensure large images are properly resized before being transferred to the web server. Additionally, images
can be saved and renamed. Access to the Image Editor is level dependent. Those who can upload files can
use the Image Editor to upload images and edit existing images, but cannot overwrite any existing image
with the same file name. Those with overwrite permissions are able to replace existing images. The Image
Editor can be accessed using the following methods:

• Within the Pages list view by clicking a linked image
• Within the Pages list view by clicking Upload and using Upload and Edit
• While inserting images on a web page using the WYSIWYG Editor > Insert/Edit Image dialog
• When editing or creating a new Web Content Asset, the mini-WYSIWYG Editor > Insert/Edit Image

dialog
• While inserting images on a page using the Source Editor

LDP Image Galleries are another way users can add images to a site in the OU Campus system. However,
this function is not related to the standard Upload and Edit Image feature and requires that Live Delivery
Platform (LDP) be enabled. For information about creating LDP Image Galleries:

Image Galleries

Image file types support by the Image Editor is browser dependent. The following file types commonly used
for web pages can be edited and saved with the Image Editor with the most commonly used browsers:

• JPG
• PNG
• GIF
• BMP

For a complete reference of browser support for image formats, see:

http://en.wikipedia.org/wiki/Comparison_of_web_browsers#Image_format_support

Image Editor Restrictions and Requirements
The image size is dependent on two factors, the browser and the amount of memory allocated to the
browser by the parent machine. In testing a fairly large image, 13260 x 3955 pixel (27 MB), was used and
rendered in 198 ms. Performance of image rendering is dependent upon each individual user's machine
and Internet connection. In short, every time a user tries to load an image, large or small, jpeg or any other
extension, the image editor relies on the browser to provide the pixel information.

If working with an image that cannot be edited, log out of OU Campus, quit and relaunch the browser. This
will free up browser-allocated RAM and may resolve the issue.

If pictures do not update to the edited version in Preview mode, the Image Editor and web browser might be
clashing. A browser stores copies of pages of visited pages, then displays these stored files upon the next
visit. This way, the browser is not being forced to load the page anew with each visit, which takes more time
than viewing a stored copy. This storage of pages is called a cache. However, this cache can sometimes
pose a problem when viewing the most updated version of a page is needed. Clear the browser's cache to

http://support.omniupdate.com/oucampus10/reusable-content/assets/image-galleries.html
http://en.wikipedia.org/wiki/Comparison_of_web_browsers#Image_format_support
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ensure viewing of the most recent versions of a page. Reloading or refreshing a page in a browser is usually
sufficient and there are more invasive method of clearing all browser data in each browser's settings.

Image Editor Tools
The Image Editor has a predefined set of tools that allow users to customize images as they wish. For more
information about the tools available in the Image Editor:

Image Editor Tools

Image Editing on Upload
Images imported into OU Campus can be edited on import. To edit images when importing: 

1. Click the Upload icon in the Pages list view. 

2. In the Upload dialog, select Upload and Edit Image. 

3. This automatically opens the local computer’s File Explorer (PC) or Finder (Mac). Locate the file and click
Open. 

4. The image is opened in the Image Editor where changes can be made to the file. 

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-editor-tools.html
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5. When all the changes have been made, click Upload. 

6. A dialog will appear. Enter the New File Name for the file, including the extension, and use the browser
to Select Destination Folder. If needed, select the checkbox for Show Files. 
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7. Click Save. 

The user is returned to the Pages list view inside the folder where the image was uploaded. 

Image Editing from Pages List View
Any image file can be edited from the Pages list view. The image editor can be used to edit images already
uploaded to the staging server.
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1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

3. Hover over the target row and click Edit, or click the hyperlinked image name. 

4. The Image Editor will open and the image can be modified. 

Editing Images in WYSIWYG Mode
To edit any image while using the WYSIWYG editor, click the Insert/Edit Image icon in the WYSIWYG
toolbar. Any image can be selected and edited using the Edit Image button in the file selector window.
Additionally, users can upload and edit any image from this same window by clicking the Upload button.

1. Click the Insert/Edit Image icon on the WYSIWYG toolbar.

  

2. Click the Browse icon to change or edit an image.
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3. Expand a folder or double-click to view thumbnails of all the images contained within that folder. Click a
thumbnail to show a preview of just the selected image.
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4. Choose one of the following actions:

• Click the Edit Image button to edit the file displayed in the Image Preview window.
• Click the Upload button to open, edit, and upload a file from a local computer.
• Click the Upload & Edit button to upload a file from a local computer and start the Image Editor.
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Insert/Edit Embedded Media
Insert/Edit Embedded Media Overview
The Insert/Edit Embedded Media button is a tool in the WYSIWYG Editor that allows users to include video
on a page and can be accessed from any page so long as the file is checked out to the user. Users can add
media from both external sources, as well as uploading files directly to OU Campus. To access the Insert/
Edit Embedded Media button, select Content > Pages from the global navigation bar and open any page
for editing. When the user clicks Insert/Edit Embedded Media, a dialog opens which includes the following
elements:

• General Tab: This tab allows users to upload the file and change basic metadata information about the
file.

• Advanced Tab: Allows users to further customize the settings which affects both how the file is
rendered and how it will be imported.

• Source Tab: Provides a source code view of the selected media.

General Tab
The General Tab of the Insert/Edit Embedded Media dialog allows users to upload video files and change
basic metadata information about the file. Currently, users can select from HTML5 Audio, HTML5 Video,
Flash, Transcode It, Quicktime, Shockwave, Windows Media, Real Media, and Iframe as the desired file
types. When a user opens the General tab, the following elements are displayed:

• Type: This drop-down menu allows users to select the type of file they will be importing. 
• File/URL: Users browse for the file on their desktop using this parameter.
• Dimensions: Allows users to edit the dimensions of the file and how it will render on the page.
• Preview: Displays a preview of the file that is being imported.
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Advanced Tab
The Advanced tab of the Insert/Edit Embedded Media dialog allows users to further customize the settings
which affects both how the file is rendered and how it will be imported. The Advanced tab is broken down
into three sections -- Advanced, Audio Options, and a third section that displays options specific to the file
type that is currently selected for importing. When a user selects the Advanced tab, the following elements
are displayed:

• ID: Users can attach an ID that can be used as reference in the source code that will help easily identify
the content.

• Name: Allows users to create a name for the video.
• Align: Users can change the alignment of the video from the available drop-down menu.  The alignment

feature helps the system identify where the video will render once it is added to a page. Users can align
to Top, Bottom, Left, or Right.

• Background: Users can change the background color of the video either by typing in a hex value into
the available text field or selecting the color from the color chooser.

• V-Space: Allows users to manually set the video's vertical spacing.
• H-Space: Allows users to manually set the video's horizontal spacing.
• Title: Allows users to add an optional metadata title.
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• Alternative Source 1: As this is an audio option, users define an external source to overwrite the
current audio of the file.

• Alternative Source 2: An additional external audio source can be added with this option.
• Preload: Allows users to choose whether the audio for the video is preloaded using the available drop-

down menu.
• Auto Play: Synchronizes the audio with the video at the initial start operation.
• Loop: Puts the audio track on a continuous and repeating loop.
• Controls: Gives users additional controls.

The third section's options will vary depending on the file type selected in the General tab of this dialog.
These options usually pertain to the specific file type's video settings, and allows users include java
elements or control parameters such as the video's volume.

Source Tab
The Source tab of the Insert/Edit Embedded Media dialog provides users a preview of the media's source
code as it would appear inserted onto a page. Users can also copy and paste this code into a PCF file to
have the media permanently embedded in the template. When users select the Source tab, the following
elements are displayed:
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Uploading Embedded Media from the WYSIWYG
Embedded media can be inserted either from an external source or directly from within the OU Campus
system. If users wish to insert embedded media from within OU Campus, they must first upload the files.
Users can not only upload from the Pages list view, but also directly from the WYSIWYG Editor. To upload
embedded media from the WYSIWYG Editor:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

2. Choose the target page and open an editable region on the page to display the WYSIWYG Editor.

3. Click the Insert/Edit Embedded Media tool and click Browse. 

4. Navigate to the directory to which the media should be uploaded and click Upload.
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5. Select the Access Group and if necessary choose to Overwrite Existing. To add files from the local
drive or server, click Add Files or simply drag and drop the files into the Upload dialog. 

6. Click Start Upload.

7. Click Insert to choose the file and return to the Insert/Edit Embedded Media tool in the WYSIWYG.

Inserting Embedded Media from OU Campus
To insert embedded media files from within the OU Campus system.

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and upload
the file to the directory chosen by the user using the Upload button.

2. From the Pages list view, select the target content to be edited and open an editable region to display the
WYSIWYG Editor. From the WYSIWYG Editor, click the Insert/Edit Embedded Media icon.
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3. Browse for the file by clicking the Browse icon in the File/URL parameter in the General tab. If browsing
for media in the file chooser, navigate to and click the desired file, similarly to browsing for images.
Supported video types can also be uploaded based on permissions.

8. Click on Insert.

The media does not render within the WYSIWYG Editor. Instead a yellow placeholder box the size of the
intended media is displayed. Once the page is saved, the video renders in the preview.

The WYSIWYG Editor uses the XHTML schema to validate the content when saving. In the case of an
<iframe>, the "name" attribute is deprecated for XHTML, and is removed. Instead, try using the ID attribute,
or id="iframename".

There are a few reasons why a video may not render:

• The browser used to view the page does not have the correct plugin.
• The type of media specified is incorrect for the media. Make sure the video appears in the Preview

screen inside of the Insert/Edit Embedded Media window.
• The video file has an incorrect or invalid file extension.

Inserting Embedded Media from an External Source
In addition to uploading embedded media files to OU Campus and inserting them with the WYSIWYG
Editor, users can also insert embedded media files from external sources, such as Youtube or other similar
video-sharing services.

1. Locate the video on an external video sharing service such as Youtube.

2. Copy the URL for the video from the top address bar.
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3. Return to the page in OU Campus where the video should be placed, and place the cursor at the location
where the video should be displayed.

4. Click on the Insert/Edit Embedded Media icon in the WYSIWYG toolbar.

5. Paste the file's URL into the File/URL box.

6. Fill out the necessary fields in the General and Advanced tabs.

7. When complete, click Insert. 
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Toolbar Row 3
Toolbar Row 3 Overview
The available tools on the third row of the toolbar are those available for inserting and editing tables and
forms within the WYSIWYG Editor. For both tables and forms, the additional features are available after the
initial table or form has been inserted on the page. Place the cursor within the element and the editing tools
will become available.

 

In addition to the Insert/Edit Table tool, other table editing functions include those for defining the properties
for table cells and rows, and for inserting and deleting rows and columns.

As with other functionality, right-clicking within a table provides a shortcut menu for table editing and
formatting.

Example of Shortcut Menu

Table Tools

Icon Tool Description

Insert/Edit Table To insert a table, position the
cursor then click the Insert/Edit
Table icon. The Insert/Edit Table
dialog includes several fields that
can be used to define the table
including:

• Columns: Number of columns
in table

• Rows: Number of rows in
table

• Cell Padding: Padding
around cells

• Cell Spacing: Spacing
between cells

• Alignment: The alignment of
the content within the cells

• Border: Thickness of the
border around the cells

• Width: Width of table
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Icon Tool Description

• Height: Height of the table
• Class: A class defining the

styling of the table
• Table Caption: Choose

whether or not to have a
caption above the table

Fill in table details, then click OK
to insert table, or click Cancel to
return to the editor.
For more information about
tables:

• Insert/Edit Table
• General tab
• Advanced tab

Table Row Properties Edit the alignment, background
color and several other
properties of the rows of the
table.

Table Cell Properties Edit the alignment, background
color and several other
properties of the cells of the
table.

Insert Row Before To insert a row above another
row, click inside the row cell the
new row is to precede, then click
the Insert Row Before icon.

Insert Row After To insert a row below another
row, click inside the row cell the
new row is to follow, then click
the Insert Row After icon.

Delete Row To delete a row, click inside the
row to be removed, then click the
Delete row icon.

Insert Column Before  To insert a column before
another column, click inside the
column cell the new column is
to precede, then click the Insert
Column Before icon.

Insert Column After  To insert a column after another
column, click inside the column
cell the new column is to follow,
then click the Insert Column After
icon.

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/tables.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/tables.html
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Icon Tool Description

Delete Column  To delete a column, click inside
the column to be removed, then
click the Delete Column icon.

Split Merged Table Cells  To split cells that have previously
been merged, select the cell then
click the Split Merged Table Cells
icon.

Merge Table Cells To merge cells, highlight the
cells to be merged, then click the
Merge Table Cells icon.

 
Form Tools
The Form tools build the client interface for the form. The site developer will need to provide the server side
form processing code. The form tools available from within the WYSIWYG are not the same as the Form
Asset provided with the Live Delivery Platform product: Live Delivery Platform Forms.

Icon Tool Description

Insert/Edit Form Create or edit the form. When
creating a new form, set all
attributes needed for the form to
function properly.

 

Delete Form Highlight the form for deletion
and click the Delete Form icon.

 

Insert/Edit Input Element Insert or modify input field such
as checkboxes, icons, or events.

 

Insert/Edit Select Element Insert or modify selection drop
down elements.

 

Insert/Edit Textarea Element Insert or modify textarea
elements.

For more information about forms, see the Forms Tutorial or Forms Reference.

http://support.omniupdate.com/oucampus10/reusable-content/assets/form-asset.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/formstutorial.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/formsreference.html
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Rename
Rename Overview
Rename allows for the renaming of files. The file is renamed on the staging and the production server.
Users assigned to Levels 8, 9, and 10 have the ability to rename files, and Level 8 users can only rename
files to which they are assigned access rights. It is important to note that files renamed on the staging server
change the associated files on the production server, but files renamed on the production server do not
change the file name on the staging server. 

Renaming a File
A file can be renamed from the Pages list view by hovering and from the File menu, selecting Rename. Note
that a file does not have to be checked out to be renamed.

1. To rename a file, navigate to the Pages List view, hover over the desired file, and from the File menu,
click Rename. 

 2. Input the new file name.

3. When the new name has been inputted, click away from the box or press the Enter key. 

While some extensions can be changed, PCF file types cannot. Likewise, a file extension cannot be
changed to PCF.

Note: Renaming a file changes its name on both the staging and production servers. As well, if Dependency
Manager is enabled, a prompt will appear when renaming a file indicating how many pages will need to
be republished should the rename process be completed. To continue, click OK. This will republish the
page based on the current version of the page on the live production server with the new dependency links.
If changes have been made but not published to the live site, those changes will still not be published to
the live production server but will be available in OU Campus and still saved on the staging server. This
includes any versions. For more information about dependency manager, see:

Dependency Manager

http://support.omniupdate.com/oucampus10/setup/account/optional-features/dependency-manager/index.html
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Copy
Copy Overview
The Copy function can be used to copy one or more pages or files. Copying a file automatically renames the
copy by appending a number. Only users assigned to levels 8, 9, and 10 can copy files, and level 8 can only
copy files to which they are assigned access rights. It is also important to note that copying files and folders
can only occur on the staging server. Copies cannot be made of assets.

Copying a Single File
A file can be copied from the Pages list view by hovering and from the File menu, selecting Copy, by
selecting the checkbox adjacent to a file, or by using the drag-and-drop feature. The location to copy to can
be browsed to or entered manually. Additionally, an option can be selected to show the files in a directory.
Note that a file does not have to be checked out to be copied, and can be copied when it is checked out to
another user or when it has a scheduled action associated with it.

Copying a File from the Pages List View
1. To copy a file do one of the following:

• From the Pages List view, hover and from the File menu select Copy.

• From the Pages List view, select the checkbox for a file and from the top row click Copy.
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2. From the dialog box, browse to the directory path to which to copy.

• Click the triangle next to a directory to show subdirectories.
• Click the Show Files checkbox to view the files within directories.
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• Alternatively, click the Ellipsis button to manually enter the path.

Copying a File by Drag and Drop
A file may be copied by dragging the file from the File Navigation to the desired location in the main content
area. 

1. Navigate to the appropriate directory for the file to be copied to in the Pages List view. 

2. Expand the File Navigation using the folder button in the top left of the screen, and locate the file to be
copied. 
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3. Holding Control (PC) or Option (Mac), drag the file from the File Navigation into the main content area to
where the file should be copied. 
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4. A confirmation dialog will appear. Click Copy. 

Copying Multiple Files
Multiple files can be copied in the same action by selecting the checkboxes found to the left of each file, and
then the Copy button at the top of the page list. All files within a directory may be selected at one time by
clicking the checkbox at the top of the list. The location to copy to can be browsed to or entered manually.
Additionally, an option can be selected to show the files in a directory. Note that files do not have to be
checked out to be copied, and can be copied when they are checked out to another user or when they have
a scheduled action associated with it.

1. To copy multiple files at one time do one of the following:
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• Select the checkbox at the top of the list to select all files, files can be deselected individually by clicking
the checkbox for a file.

• From the Pages List view, select the checkbox for each file to be copied and from the top row click
Copy.

2. From the dialog box, browse to the directory path to which to copy.

• Click the triangle next to a directory to show subdirectories.
• Click the Show Files checkbox to view the files within directories.



OU Campus Copy Page 84 of 188

• Alternatively, click the Ellipsis button to manually enter the path.

3. When the location has been selected, click Copy. 
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Move
Move Overview
The Move function allows for the moving of one or more files at a time. Only users assigned to levels 8, 9,
and 10 can move files, and a Level 8 user can only move files to which they are assigned access rights. It
is also important to note that moving files and folders will move them on both the staging and production
servers. If a page or file has not been published, it will only be moved on staging. If Multi-Target Publish is in
affect, the files are moved to any target to which it has been published.

Moving a Single File
A file can be moved from the Pages list view by hovering over the desired file and from the File menu,
selecting Move, by selecting the checkbox adjacent to a file, or by using the drag-and-drop feature. The
location to move to can be browsed to or entered manually. Additionally, an option can be selected to show
the files in a directory. Note that a file does not have to be checked out to be moved. 

Moving a File from the Pages List View
1. To move a file, do one of the following: 

• From the Pages List view, hover over the desired file and from the File menu select Move. 

• From the Pages List view, select the checkbox for a file and from the top row click Move. 

2. From the dialog box, browse to the directory path to which to move. 

• Click the triangle next to a directory to show subdirectories. 
• Click the Show Files checkbox to view the files within directories. 
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• Alternatively, click the Ellipsis button to manually enter the path. 

3. When the desired directory is located, click the Move button. 

Moving a File by Drag and Drop
A file may be moved by dragging the file from the File Navigation sidebar to the desired location in the main
content area. 

1. Navigate to the appropriate directory for the file to be moved to in the Pages List view. 

2. If necessary, expand the File Navigation using the folder button in the top left of the screen, and locate
the file to be moved. 
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3. Drag the file from the File Navigation into the main content area to where the file should be moved. 
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4. Click Move. 

Moving Multiple Files
Multiple files can be moved in the same action by selecting the checkboxes found to the left of each file, and
then clicking the Move button at the top of the page list. All files within a directory may be selected at one
time by clicking the checkbox at the top of the list. The location to move to can be browsed to or entered
manually. Additionally, an option can be selected to show the files in a directory. Note that files do not have
to be checked out to be moved. 

1. To move multiple files at one time, do one of the following: 
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• Select the checkbox at the top of the list to select all files, and click Move. Files can be deselected
individually by clicking the checkbox for a file. 

• From the Pages List view, select the checkbox for each file to be moved and from the top row,
click Move. 

2. From the dialog box, browse to the directory path to which to move. 

• Click the triangle next to a directory to show subdirectories. 
• Click the Show Files checkbox to view the files within directories. 
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• Alternatively, click the Ellipsis button to manually enter the path. 

3. When the desired location has been selected, click the Move button. 

Note: If Dependency Manager is turned on, a prompt will appear when moving a file or files indicating how
many pages will need to be republished should the move process be completed. To continue, click OK.
This republishes the page based on the current version of the page on the live production server with the
new dependency links. If changes have been made but not published to the live site, those changes will still
not be published to the live production server but will be available in OU Campus and saved on the staging
server. This includes backed up versions. For more information about Dependency Manager, see: 

Dependency Manager

http://support.omniupdate.com/oucampus10/setup/account/optional-features/dependency-manager/index.html
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Recycle & Restore
Recycle and Restore Overview
The use of the recycle bin is a site-by-site configuration that may or may not be enabled by default for an
account. If the recycle bin is not configured for a site, then files can only be permanently deleted rather than
being moved to the trash. Files in workflow cannot not be immediately recycled; that is, if a page is locked
by a user or pending approval by another user, the administrator would need to check in a page that is
locked by another user before it can be recycled. Not all users have inherent rights to recycle, restore, and
delete. Recycle bin permissions are configured by an administrator for user levels 1 through 7. Level 8 users
can only delete files and folders to which they are assigned access rights. When files on the staging server
are moved to the trash, any derivatives are subsequently permanently deleted.

In the context of OU Campus when the recycle bin is enabled the following functionality is available:

• Move to Recycle Bin: In other words, moving a file to the recycle bin is recycling it. A file moved to the
recycle bin can be restored from the recycle bin.

• Restore: A file can be restored from the recycle bin.
• Delete: Files can be permanently deleted from the recycle bin after being moved to the trash. A directory

can only be deleted, as no recycle functionality is available for a directory.
• Empty: The recycle bin can be emptied to permanently delete all files in the recycle bin.

If a site is not employing the recycle functionality, for more information about deleting see:

Deleting Files & Directories 

For more information about setting up a recycle bin see:

Recycle Bin Configuration

Moving a File to the Trash
1. From the Content > Pages view, hover over the menu bar for a file and from the File menu choose Move
to Recycle Bin.

Alternatively, a page can be selected by clicking the adjacent checkbox, and Move to Trash is made
available.

http://support.omniupdate.com/oucampus10/pages/file-options/delete.html
http://support.omniupdate.com/oucampus10/setup/sites/site-settings/rcyc.html
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2. The resulting dialog warns that the selected file and any derivatives on production will be deleted. When
the recycle functionality is enabled for a site, pages on the staging server must be recycled before they can
be permanently deleted. A recycled page or file can also be restored from the recycle bin if necessary. After
a page has been restored, it must be re-published to the production server. When a page is recycled on the
staging server, the published derivatives are automatically deleted from production servers. Likewise, a file
can also be solely deleted from the production server or other publish target by navigating to the Production
button or button for the publish target, and deleting it. The recycle bin functionality does not extend to these
servers. Once a file is deleted from the production server or publish target, it cannot be restored. It can be
re-published from the main file on the staging server with any routine form of publishing, such as publish,
site publish, directory publish, or scheduled publish.

3. Click Move to Recycle Bin. The files are moved to the trash.

Note that a page or file checked out to another user or that has been scheduled for an action by another
cannot be moved to the recycle bin.

MultiFile Recycle
Multiple files can be recycled with the same action by selecting the the checkbox in the header row of a list
or each checkbox adjacent to the file name and clicking Move to Recycle Bin. Note that when performing
a multi-object selection that includes directories, only Delete is available as directories cannot be recycled.
Using a multifile section can be useful to simulate a directory recycle, as in this manner, all files within
a directory can be selected for moving to the recycle bin, which will then allow the files to be restored, if
necessary.
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Note when selecting multiple files and a page or file checked out to another user or that has been scheduled
for an action by another is included in the selection, Move to Recycle Bin is not available as it is not possible
to recycle those pages.

The resulting dialog enumerates how many files will be moved to the trash and warns that derivative files on
production will be deleted.

About the Recycle Bin
The recycle bin is only for files on the staging server. Files deleted from the production server that do not
have a direct counterpart on the staging server are deleted permanently and are not recoverable. When a
file is sent to the recycle bin on the staging server, the file and all of its version history as well as its path and
access rights are all moved to the recycle bin. All files that were created on the production server from the
file being sent to the recycle bin are permanently deleted from the production server.

The recycle bin is for files only, as directories can not be sent to the recycle bin. Deleting a directory will
permanently delete all files and folders contained in the directory from both the staging and production
servers. This is the same function as when there is no recycle bin configured for a web site.

Multiple files of the same name and (and path) can be sent to the recycle bin. They are all listed in the
recycle bin but with a -# (e.g., file-1.ext, file-2.ext) appended to the subsequent files that are moved to the
recycle bin.

The recycle bin is not meant to be used as an archive. If a file is sent to the recycle bin, and later the
directory is deleted, if the file is selected to be restored, the original path to the file is recreated and the file
moved back. None of the access properties that may be necessary to publish the page will exist as they
are stored with the directory, and the original directory was deleted. The access settings and/or directory
variables will need to be set by the administrator in order to manage or publish the file. 

Directories
Directories cannot be recycled on staging or on a production server. Directories that are deleted are
permanently deleted. The multiple file recycle function can be used to simulate a directory recycle. Select all
files within a directory with the checkbox located above the view of the folder structure and click the Recycle
Bin icon in the same area to recycle the files. Then the directory can be deleted. Recycling files within a
directory in this method allows the files to be individually restored if needed.

To delete the directory from the Content > Pages view, hover over the menu bar for the directory and from
the File menu choose Delete.

Alternatively, a directory can be selected by clicking the adjacent checkbox, and Delete is made available.

Restoring a Page from the Recycle Bin
A singular file can be restored from the trash or multiple files can be restored.

1. To view the contents of the trash, click the Trash icon.
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2. The Trash screen is displayed. The screen can be sorted on the following columns: file type, Name,
Original Location, and Delete Date. The list can also be filtered by name.

3. Hover over the menu bar for the file and in the Options column choose Restore.

Alternatively, a single file or multiple files can be selected by clicking the adjacent checkbox, or multiple files
can be selected by clicking the checkbox from the top row.

5. Click Restore.

Deleting from the Recycle Bin
A singular file can be permanently deleted from the trash, multiple files may be selected all for deletion at
one time, or the entire trash can be emptied.

1. To view the contents of the trash, click the Trash icon.

 

2. The Trash screen is displayed. The screen can be sorted on the following columns: file type, Name,
Original Location, and Delete Date. The list can also be filtered by name.
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3. Hover over the menu bar for the file and in the Options column choose Delete.

Alternatively, a single file or multiple files can be selected by clicking the adjacent checkbox, or multiple files
can be selected by clicking the checkbox from the top row.

4. Click Delete.

The entire trash can be emptied without selecting files by clicking Empty Trash.

 
A Bit More About Restore 
When a file is restored from the recycle bin, the file, its version history and file permissions are moved back
to the original location on the staging server. The file must be published to return the file to the production
server. If a file of the same name and with the same directory path as a recycled file has been created, it
should be renamed or moved before restoring.

A file can be restored or permanently deleted from the recycle bin, or the entire recycle bin can be emptied.
The recycle bin can be used by level 8, 9, and 10 users. Level 8 users can access the recycle bin, but are
only able restore files they have deleted.
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Recycle Bin Permissions
Inherently, only administrators and Level 8 users can recycle, restore, and delete files, and the functionality
for Level 8 users only extends to files to which they have access. Directories and assets can only be
deleted. Administrators can assign permissions for recycling and deleting files, and for deleting directories
to Level 1–7 users as desired. As for user level 8, this functionality only extends to items to which they have
access, and they are only able to restore files that they recycled.

Level 8: A Level 8 user can recycle files for which they have access and publish permissions. They can
restore files that they did not sent to the recycle bin.

Level 9: A Level 9 user can recycle files for which they have access and publish permissions. They can
restore and delete files recycled by other users.

Level 10:  A Level 10 user can recycle and restore any file and can also permanently delete any file
including emptying the trash using the empty trash icon. Once the trash is emptied those files are
permanently deleted.
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Delete
Deleting Files and Directories
If the recycle bin is not configured for a site, then files can only be deleted. Even if recycle is in use,
directories can only be deleted. The files within a directory can be recycled first to ensure that the files can
be restored in the event that a restore is required.

Deleting directories, pages, and other files completely removes them from the system, including any
previous versions or backup. Deleting files and directories deletes them from both the staging and
production servers. Delete with caution.

Only users assigned to levels 8, 9, and 10 can delete files and directories, and level 8 users can only delete
files and directories to which they are assigned access rights. 

It is more common that a recycle bin is configured for a site and this allows for recycling files from the Pages
list view, with the additional functionality of restoring or permanently deleting from the Recycle Bin screen.
For more information:

Recycle & Restore

Deleting a File
Files can be permanently deleted from the Pages list view. 

1. Navigate to the Pages list view and locate the file to be deleted.
2. Hover over File on the page row and select Delete. 

3. A dialog will appear to confirm the delete. Click the red Delete button.

http://support.omniupdate.com/oucampus10/pages/file-options/recycle-bin.html
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Deleting Multiple Files
1. Navigate the folder structure in Content > Pages and locate the files that are to be deleted.
2. Select the appropriate checkboxes for each file. The checkbox at the top of the column selects all

files in the directory.
3. Click the Delete button at the top row of the file structure view.

4. A dialog box will appear to confirm the delete. Click the red Delete button.

Note: Deleting a file or files removes any previous versions or backup version. Deleting removes them from
both the staging and production servers.

Deleting a Directory
Directories cannot be recycled on the staging or production server. Directories that are deleted are
permanently deleted. If recycle is available for the site, all the files in the directory can be recycled and
then the directory deleted. This allows for the directory to be recreated and the files restored if necessary.
Otherwise, deleting a directory deletes all contents within the directory on both the staging and production
servers. Files within a directory are removed as are any previous versions and backups.

1. Navigate the folder structure in Content > Pages and locate the desired directory.

2. A directory can be deleted either by hovering over the File menu and selecting Delete.
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Alternatively, a directory can be deleted by selecting the checkbox next to the directory, and
selecting Delete from the options above the file navigation.

3. A dialog box will appear to confirm the delete. Click the red Delete button. 
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Review
Review Overview
Several items of functionality exist within the OU Campus content management system to assist in the
review of pages and other content. Within this category, information is provided specific to the review of
pages, including utilizing a workflow process for approval of the content of pages. While the information is
specific to pages, the review of content throughout the system for other types of content, specifically assets
and if applicable binary files, is very similar to the information provided here. Users can review content either
from the Pages list view or from the Page Actions toolbar. For Assets, review options can be selected from
the Assets list view or the Asset Actions toolbar.

The options available in the Review menu are dependent on user permission level as well as the current
status of the content. Content that is not checked out will have fewer options available. Pages that are not
checked out will only have the following options available by default:

• Preview
• Log

On the other hand, content that is checked out displays the following options by default:

• Preview
• Page Check
• Save Version
• Versions
• Log

Not all users will have the same permissions and therefore will not all have the same options available even
if the content is checked out.

Preview
Prior to checking out or editing a page, a page can be previewed. This view provides limited functionality
in that no buttons are available for editing, saving . Preview does allow for server selection, which can be
used in conjunction with Multi-Target Publish to provide views of different variations of the same page prior
to publishing to the live production server. For more information:
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Preview

Page Check
The system includes methods for configuring several "checks" that can be run manually and/or at the time
of page publish, and which can be required to be performed. The available checks include tools for spell
check, link check, page validation, and an accessibility check of which one of several specifications can be
designated. For more information:

Page Check

Save Version
During the review process, or veritably at any time, a user or reviewer can commit a version of a page, and
later if or when necessary, revert to a previous version of a page. The current state of a page on staging can
be compared with the current published version of a page or with previous versions of a page. The resulting
comparison includes color-coded markup indicating how the pages differ. For more information:

Save Version

Versions
The Versions tool allows users to access and review previous saved versions of content on the staging
server and allows for comparison between versions, including the version on the production server. For
more information:

Versions

Log
In addition to the built-in versioning system, the system also maintains a log file for a page. This displays
all of the saves and publishes, whether manual, scheduled, or if it was part of a directory publish, that have
occurred for a specific page. For more information:

Log

http://support.omniupdate.com/oucampus10/pages/review/preview/index.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/index.html
http://support.omniupdate.com/oucampus10/pages/review/versions.html
http://support.omniupdate.com/oucampus10/pages/review/versions.html
http://support.omniupdate.com/oucampus10/pages/review/log.html
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Preview
Preview Overview
Prior to checking out or editing a page, a page can be previewed. This view provides limited functionality in
that no buttons are available for editing or saving the file. Preview does allow for server selection, which can
be used in conjunction with Multi-Target Publish to provide views of different variations of the same page
prior to publishing to the live production server. With Multi-Output Preview, the page can be previewed in all
published formats (for instance, HTML and PDF). With Multi-Browser Preview, it is also possible to preview
the page as it will appear in other browsers across multiple platforms. The rendered preview of a page will
display all graphics and server-side includes. Other server-side scripting code is not be displayed in Page
Preview mode. Preview can be utilized with various alternative publish targets, if Multi-Target Publish is
being used. The page preview includes the graphics, server-side includes, and assets. The default preview
is the first product declaration.

The Preview screen also allows users the ability to use Multi-Browser Preview and Multi-Output Preview.
Multi-Browser Preview is a handy test tool to preview a page as it is rendered by any number of browsers
on either or both the Windows or Mac OS operating system. Multi-Output Preview refers to the drop-down
by which an output can be reviewed prior to publishing. For example, if the template configuration for a page
includes publishing as a PDF as well as an HTML file both outputs are available for preview. This requires
that the XML portion of the template include the pcf-stylesheet declaration that among other attributes
includes the path to the stylesheet that assists in the transformation of the page. For more information:

Navigating
Preview can be navigated from the folder structure viewable from Content > Pages or from DirectEdit log
in. Pages can be previewed whether it is checked out to the current user or not, and users can preview files
checked out to others. Immediately after editing and saving a page, a rendered preview is displayed, with
the option to see a preview in other browsers. It is possible to navigate to the preview at any time using the
Preview button.

Page Preview from Content > Pages View

Page Preview with Preview or Edit Modes

Multi-Output Preview
Multi-Output Preview can be used to display the other products that have been configured. Use the drop-
down on the right to choose the output for preview. 

Contributors can preview pages rendered with different file type formats, including HTML, PDF, RTF, CSV,
XML, and mobile, as well as any UTF-8 compatible foreign language formats (including two-byte languages
such as Chinese and Japanese). If an XSL template is designed to output multiple files, Multi-Output
Preview provides the ability to view the outputs together before publishing. For more information, see:
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Multi-Output Preview

Multi-Browser Preview
Users can select different browser and platform combinations such as Mac OS or Windows to preview a
page before publishing, resulting in full-resolution screenshots of the page in each selected browser. For
more information, see:

Multi-Browser Preview

Publish Target
When Multi-Target Publish has been enabled and alternative publish targets defined, then the publish
targets can be selected for preview.

http://support.omniupdate.com/oucampus10/pages/review/preview/preview-multi-output.html
http://support.omniupdate.com/oucampus10/pages/review/preview/preview-multibrowser.html
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Page Check
Page Check Overview
Page Check is an account-wide feature with several customization options that can be applied at the
account, site, and even user level. Because of the flexibility of the implementation of the various quality
assurance checks that can be run on a page, the available options described here may vary for an
institution's implementation. The four basic types of checks available with Page Check are:

• Spell Check
• Link Check
• W3C Valid
• Accessibility Check

Depending upon configuration, the Page Check can be initiated while in preview or edit mode for a checked-
out page, while editing a page, or at the time of publish. All of the four quality checks may be enabled to run
or any combination of the available checks may be enabled to run. It can be forced to run automatically at
the time of publish as Final Check. A user can also configure to enable Page Check in their individual user
settings if this option was configured at the account level.

If Page Check was disabled, the item does not appear as an option on the Review menu nor is it available
when the page is checked out.

In addition to the options available for configuration of Page Check, the individual checks have their own
options. For example, a language option is available for Spell Check and a choice of specification is
available for Accessibility Check.

Initiating a Page Check
Keep in mind that identified errors for all four options can include issues that are in specific areas on a page
that cannot be edited by the user. For instance, if the error is in the header, this is generally only editable by
an administrator. In those cases, the user should pass on the identified error to an administrator to have it
updated.

From the Folder Structure (Content > Pages)
1. Navigate to Content > Pages and check out the desired page.
2. Hover over the menu bar and Review menu, and choose Page Check.

From Preview, Edit, or Editing
1. When the page is checked out, the Page Check icon is available in the page actions toolbar.
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2. Click Page Check icon.

As Final Check
If in addition to Page Check, Final Check is enabled (and perhaps even required), then initiating a publish
will either make the enabled page checks available, or run them automatically.

Choosing Various Options
The four basic types of checks available for Page Check can be enabled on an option-by-option basis. All
may be force enabled by an administrator to run by default when publishing a page. All may be available to
run or any combination of checks may have been configured to be available.

Icon Description

Spelling: Includes the ability to select from five
languages that include English, Spanish, French,
Italian, or Portuguese.
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Icon Description

Links: Link Check checks the links for both internal
and external links, identifies any broken links, and
provides additional warnings.

W3C Valid: W3C Valid identifies any W3C
compliance issues (both errors and warnings) with
a page.

Accessibility: Accessibility Check identifies
any issues that may be present relating to the
type of accessibility standards configured by an
administrator.

1. From the Page Check dialog, choose the output type to be checked from the drop-down. Only one option
may be available, such as HTML, but other outputs may be checked.

2. If necessary, choose the language for Spell Check.

3. To choose to run all of the checks, click the Run All button.

4. To run each type of check separately, click each individual option to run.

5. After running each check, the item is shown in red if there were errors, warnings, or other issues in the
results. The results can be viewed by clicking the link below the errored item. The item is shown in green if it
passed the check.
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Example of Page Check for Spelling with Errors

6. Click Done when finished reviewing the results.

Analyzing Results of the Error Reports
Each of the four types of checks provides reporting of the errors that were discovered. For details about the
results of each of the four checks:

• Spell Check
• Link Check
• W3C Valid
• Accessibility Check

Enabling Page Check in User Settings
One of the configuration options available at the account level is for an administrator to enable Page Check
to be user enabled. When Page Check is user enabled, the currently logged in user can choose to enable
Page Check from within their user settings.

http://support.omniupdate.com/oucampus10/pages/review/page-check/spell-check.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/link-check.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/w3c-valid.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/accessibility-check.html
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1. Hover over the user name on menu bar and choose Settings from the menu.

2. Choose Preferences from the menu.

3. Click Save.

Any Page Check options enabled for the account are now available for the user.
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W3C Valid
W3C Valid Overview
W3C Valid identifies any W3C compliance issues with a page. This can assist in determining the validity
of web documents. Most web documents are written using markup languages, such as HTML or XHTML.
These languages are defined by technical specifications, which usually include a machine-readable formal
grammar and vocabulary. The act of checking a document against these constraints is called
validation

, and this is what W3C Validate does. 

Validating web documents is an important step that can dramatically help with improving and ensuring
presentation quality. This validator can process documents written in most markup languages. Supported
document types include the following:

• HTML5 (when HTML5 Schema for the WYSIWYG Editor is in use)
• HTML (through HTML 4.01)
• XHTML (1.0 and 1.1)
• MathML
• SMIL
• SVG (1.0 and 1.1, including the mobile profiles)

The W3C Valid can also validate web documents written with an SGML or XML DTD, provided they
use a proper document type declaration. This validator is also an HTML validating system conforming
to International Standard ISO/IEC 15445—HyperText Markup Language, and International Standard
ISO 8879—Standard Generalized Markup Language (SGML), which means that in addition to W3C
recommendations, it can validate according to these ISO standards.W3C Valid can be run from the Page
Check dialog.
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Additionally, W3C Valid can be performed from the Final Check dialog, if so configured. Depending upon the
configuration, it may run automatically during Final Check; otherwise, it can be selected to run on its own or
as part of the Run All option. The output to check, which frequently defaults to HTML, can be chosen from
the drop-down.
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W3C Validation Results Dialog
When there are W3C errors on the currently selected page, and the user has selected the W3C button from
either the Page Check or Final Check dialogs, then the W3C Validation Results dialog is displayed. This
dialog includes the following elements:

• Results: This field provides a summary of the W3C validation test.
• Checked By: The tool used to perform the validation test.
• Doctype: The document type of the file being tested.
• Character Set: The syntax used in the file being tested.
• Validation Output: Provides users with a summary of entries found in the content that either contain

w3c errors or warnings.
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• List View: Provides users with a list view of each error with relevant attached information. 

 

Each item, whether the test identified error items or warning items, will display in the W3C Validation
Results dialog. Each item identifies a line of code, along with a helper message indicating the problem and a
preview of the problem content. In some instances, a solution or additional helper text will be displayed per
item when available.

Performing a W3C Valid Test
There are several different methods to performing a W3C Valid test. To perform a W3C Valid test from the
Pages list view:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

2. Hover on the target page's row and select Page Check from the Review menu to display the Page
Check dialog. Additionally, selecting Publish from the Publish menu to display the Final Check dialog will
also provide the ability to perform a W3C Valid test.

3. Click the W3C Valid button to display the W3C Validation Results dialog. Regardless if the user has
navigated to the Page Check or Final Check dialog, the W3C Valid button should be available in either
dialog.

Users can also perform a W3C Valid test from the Page Actions toolbar:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and select
the page to be edited. Additionally, selecting the page from the File Navigation sidebar also displays a view
with the Page Actions toolbar included.
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2. Click the Page Check button in the Page Actions toolbar to display the Page Check dialog. Additionally,
clicking the Publish button displays the Final Check dialog.

3. Click the W3C Valid button to display the W3C Validation Results dialog. Regardless if the user has
navigated to the Page Check or Final Check dialog, the W3C Valid button should be available in either
dialog.
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Spell Check
Spell Check Overview
Spell Check utilizes the OU Campus global dictionary, as well as a custom site-wide dictionary, to spell
check a page. Administrators can grant access to users to add words to the custom dictionaries. Any words
in the custom dictionaries are ignored by the spell checker and not marked as incorrect. The language may
be selected from a drop-down menu with a choice of English, Spanish, French, Italian, or Portuguese. Users
can access the Spell Check tool from the Page Check dialog.

Additionally, Spell check can also be performed from the Final Check dialog, if enabled. Depending upon
the configuration, it may run automatically during Final Check; otherwise, it can be selected to run on its own
or as part of the Run All option.
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Spell Check is also available during editing in the WYSIWYG Editor, if the option has been made available
on the toolbar that is in use. The WYSIWYG Spell Check can be toggled on and off by a user and provides
on-screen indication of misspelled words, and uses the default custom dictionary, which can be changed
when editing a page by selecting the language from the drop-down.

While both utilize the same dictionary files, Spell Check in the WYSIWYG Editor provides a spell check of
the region that is being edited, while a spell check run as Page Check or Final Check spell checks the whole
page as manufactured as part of the publish. In this way the spell check can detect additional misspelled



OU Campus Spell Check Page 116 of 188

words that may be present in an include file or XSL, for example, and also possible in the different output
formats that can be chosen such as HTML or TXT. For information regarding the WYSIWYG spell checker:

WYSIWYG Spell Check

When errors are encountered, the Spelling button highlights red and displays the number of errors
underneath the button. This is also a link to the error report. The error report displays any misspelled word
and, within parentheses, the number of occurrences of that word. If the word is not misspelled, it may need
to be added to the custom dictionary.

Spell Check Results Dialog
When users click the Spelling button, the Spell Check Results dialog is displayed. This dialog provides
users with a list view of all misspelled words on the currently select page. Although this dialog identifies the
errors, users must navigate to the WYSIWYG Editor to actually edit the content and correct the errors. If the
WYSIWYG Spell Check is not enabled, a user may manually search for and correct the misspelled word.
If a word is spelled correctly but is being flagged as a misspelled word, the word can either be ignored or
added to the custom dictionary with the WYSIWYG Spell Check tool.

Performing a Spell Check
There are several methods to performing a Spell Check:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

2. Hover on the target page's row and select Page Check from the Review menu to display the Page
Check dialog. Additionally, selecting Publish from the Publish menu to display the Final Check dialog will
also provide the ability to perform a W3C Valid test.

3. Click the Spelling button to display the Spell Check Results dialog. Regardless if the user has
navigated to the Page Check or Final Check dialog, the Spelling button should be available in either
dialog.

Users can also perform a Spell Check test from the Page Actions toolbar:

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/spellcheck-dictionary.html
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1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and select
the page to be edited. Additionally, selecting the page from the File Navigation sidebar also displays a view
with the Page Actions toolbar included.

2. Click the Page Check button in the Page Actions toolbar to display the Page Check dialog. Additionally,
clicking the Publish button displays the Final Check dialog.

3. Click the Spelling button to display the Spell Check Results dialog. Regardless if the user has
navigated to the Page Check or Final Check dialog, the Spelling button should be available in either
dialog.
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Link Check
Link Check Overview
Link Check allows users to verify the validity of on-page links, both internal and external, and provides
information for users that allows them to correct the issues associated with broken links. Link Check is
a feature of two different tools, Final Check and Page Check. Users can run a Page Check by selecting
Content > Pages from the global navigation bar and selecting Page Check from the available row options
for the target file. This action displays the Page Check dialog, which includes a button for the Link Check
tool.

Additionally, Link Check can be performed during a Final Check. In order for this functionality to be
available, Final Check must be enabled. If enabled, the Final Check dialog displays which includes a button
for the Link Check tool.
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When users click the Link Check button, it will run a test that will validate all on-page links for the selected
page. There are three different indicators that will display after a Link Check has been performed:
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If there were no errors during the Link Check report, the button is shaded green and the message "OK"
displays to inform the user that all on-page links are valid.

If there are potential problems that are fixable that the Link Check report identifies, the Link Check button is
shaded yellow and the message "Warning" with a numerical value indicates the number of potential errors.

If there are any errors confirmed by the Link Check report, the Link Check button is shaded red and the
message "Error" with a numerical value indicates the number of confirmed broken links. When users click
Show Results, the Link Check Results dialog is displayed. This dialog includes the following elements:

• Link Check List View:The list view provides users with a way to view all of the on-page links that
appear within the content currently being edited.

• Link Check Legend: The legend that is displayed in the dialog helps users identify the status of each
link, and also identifies errors caused by broken links.

Link Check Results List View
The Link Check Results dialog is displayed when a user performs a Link Check action. For each row
item, the path of the file is displayed with a number next to it. These numbers are representative of error
codes, and should a link contain an error, the corresponding error code number is displayed and the row's
background changes color to reflect the status of target link.
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Link Check Legend
The row items displayed in the Link Check Results dialog are color coded and labeled with numbers to help
users identify broken links using known syntax error codes. A legend is displayed at the bottom of the Link
Check Results dialog and provides the following explanation of both error code number as well as status
color code:

Performing a Link Check
To perform a Link Check action:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

2. Hover on the target row to display the available actions and select Page Check from the Review menu.
Additionally, selecting Publish from the Publish menu will also display the Link Check button.

3. Click Link Check to perform the action.
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4. Click Show Results to open the Link Check Results dialog.
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Accessibility Check
Accessibility Check Overview
Accessibility Check identifies any issues that may be present relating to the type of accessibility standards
configured by an administrator. When running an Accessibility Check, problems may be found according to
the guidelines for accessibility chosen by the administrator. These errors will appear as red, hyperlinked text
beneath the Accessibility button. Any found problems may be viewed by clicking on the problem, and this
action will open a list inside the current page check or final check dialog.

There are several ways an Accessibility Check can be performed. First, users can access this tool from the
Page Check Dialog.

Depending upon the configuration, Accessibility Check also runs automatically during Final Check;
otherwise, it can be selected to run on its own or as part of the Run All option. The output to check, which
frequently defaults to HTML, can also be chosen from the drop-down.
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An administrator can configure Accessibility Check for one of the following standards and the results will
reflect the guidelines that were chosen.

Standard Definition

WCAG Web Content Accessibility Guidelines: Includes
both 1.0 and 2.0 specifications as well as all three
priority levels (A–AAA).

Section 508 USA federal requirements for accessibility
standards.
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Standard Definition

Stanca Act Italian requirements for accessibility standards.

BITV 1.0 German accessibility standards.

Accessibility Check Results Dialog
When users click the Accessibility button from either the Page Check dialog or the Final Check dialog, the
Accessibility Check Results dialog is displayed. This dialog displays a list view of all problems, both verified
and unverified. Each item displayed in the Accessibility Check Results dialog includes reference to the
exact line in which the errors are found, including the source code and an explanation of the problem. The
following categories may be configured for types of errors:

• Known Problems
• Likely Problems
• Potential Problems

Known problems are problems that have been verified as broken or creating an error. These problems are
identified by the red icon next to each list item. If available, a helper message may appear with each list
item, helping users identify a solution to repairing the problem.
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Likely Problems are items that the OU Campus system identifies as most likely being an error, but is
required to be reviewed by a user to designate if the problem is real or not.

 Potential Problems are similar to Likely Problems in that they are not verified, but the system has identified
code which may or may not cause errors and is required to be reviewed by a user.
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Performing an Accessibility Check
There are several ways to perform an Accessibility Check:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

2. Hover on the target page's row and select Page Check from the Review menu to display the Page
Check dialog. Additionally, selecting Publish from the Publish menu to display the Final Check dialog will
also provide the ability to perform a W3C Valid test.

3. Click the Accessibility button to display the Accessibility Check Results dialog. Regardless if the user
has navigated to the Page Check or Final Check dialog, the Accessibility button should be available in
either dialog.

Users can also perform a Accessibility Check test from the Page Actions toolbar:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar and select
the page to be edited. Additionally, selecting the page from the File Navigation sidebar also displays a view
with the Page Actions toolbar included.

2. Click the Page Check button in the Page Actions toolbar to display the Page Check dialog. Additionally,
clicking the Publish button displays the Final Check dialog.

3. Click the Accessibility button to display the Accessibility Check Results dialog. Regardless if the user
has navigated to the Page Check or Final Check dialog, the Accessibility button should be available in
either dialog.
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Versions
Versions Overview
A unique version of a page is saved through the automatic version control system every time a page is
published. A backup version of a page can also be created at will with the use of the Save Version button.
It can be useful to create a permanent version or backup of the page before extensive editing. It is also
important to note that any version descriptions or publish notes added at the time of page publish are shown
in the Description column.

The Versions screen shows this list of saved versions of a page. It can be accessed from the folder
structure or while previewing or editing a page. Before navigating from editing a page to viewing versions,
the page should be saved. The Versions screen:

• Shows the number of versions saved for the page
• Shows a sortable list of versions, which includes the revision number for the page, the date it was saved,

the page author, the version description given with the save or publish, and other options
• Allows for comparing the current staging version to the current production version
• Provides a method for saving another version of the page
• Allows for reverting to a previous version of the page 

Example of Versions Screen

Saving a New Version
Although a unique version of a page is saved in the OU Campus automatic version control system every
time a page is published, users can also create a version at any time. For example, after editing and saving
a page several times, a user may wish to create a permanent version or backup of the page before moving
on with further edits such as a find and replace. When editing a page, the Save Version button is available
for this purpose. The Save Version button is also available in Preview mode.

1. To save a version of a page, either:

• Preview a checked out page, or enter into the Edit mode of a checked out page. Click on the Save
Version button in the Page Actions Toolbar. 
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• Enter the Pages List view and check out the desired page. Hover over the Review menu and
select Save Version. 

2. This opens the Save Version dialog. If so desired, click the linked current state text to see a preview of
the page as it exists on staging.

 

3.  Although optional, it is recommended to enter a bit of descriptive text for the version. This can be viewed
from the Versions screen and can be a useful clue in the future if it is necessary to determine that a page
should be reverted and to which version it should be reverted.

4. Click Save Version. A success message is displayed briefly. 
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Navigating to Versions
From the Folder Structure
The Versions screen can be accessed from the Pages list view of the site. 

1. Navigate to the Pages list view and check out the desired page.

2. Hover over Review on the page row and choose Versions. This displays the Versions screen.

From Preview or Edit
The Versions screen can also be accessed while in Preview or Edit mode, or while editing a page with the
WYSIWYG Editor. Note that the page must be checked out to the current user.

1. Check out a page and view the page in Preview or Edit mode.

2. While viewing the checked out page, click the Versions button. This displays the Versions screen.

Filtering Versions
The Versions list can be filtered by entering characters in the Filter field. The filter is relevant to the
Revision, Author, and Message columns, and items with matching character strings are displayed in the
list. The rest are hidden until the filter is removed, which can be accomplished by clicking the circle-x icon.
Filtering can be used to help locate a specific version of a page.

Comparing Versions
The compare feature includes the ability to compare different versions of a page. Options of the feature
include the capability to show or hide includes and to compare the rendered page or the source code for
the page. The current version of the page can be compared with previous version or with the production
version. When compared with other versions a source code comparison is rendered and includes files are
included.
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Comparing with Production Version
1. From the Versions screen click Compare Current to Live.

2. The comparison is shown for the rendered page in the default mode. Information about the compare will
display above the rendered page. 

3. If so desired, click Hide Includes to hide any include files that are part of the rendered page.

4. Additionally, if it is required to view a comparison of the source code, click Source to view a comparison
in source code mode.

Options for Comparing Current Version to Live 

Comparing with a Previous Version
1. Locate the previous version that is desired. The different versions can be scrolled through, or a version
number may be entered to jump directly to that version.

2. From the Versions screen, navigate to the row for the page version and hover over Compare. A user
may select from here to compare the page as is, without includes, or in source mode. By default, the page
previews with includes. The page comparison view is displayed. 

For more information about the color coding in comparing and examples, see:

Compare

Sorting Versions
Page versions can also be sorted by clicking any of the available columns:

http://support.omniupdate.com/oucampus10/pages/review/compare.html
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Revision: The default sort is reverse numerical with revision 1 showing at the bottom of the sorted list

Save Date: Date last saved

Author: Shows the user that performed the page action

Message: Shows the version description text that was entered when the version was saved

Options: Three options are available: View, Compare, and Revert. Additionally, from the view menu a user
can choose to view the version of the page or the source of the page version.

Viewing a Revision
From the Versions screen, a version of the page can be viewed and the source can be viewed. These views
of a page version are provided in a separate browser window or tab.

Viewing a Page Version
From the Versions screen, hover over the row for the version and from View, select Page. The page is
displayed.
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Viewing the Source
From the Versions screen, hover over the row for the version and View, select Source.
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Reverting to a Version
The Versions screen includes the ability to revert to a previous version of a page.

1. From the Versions screen, hover over the row for the version and click Revert.

2. The confirmation dialog is shown.

3. Click Revert.

4. A success message shows to which version the page was reverted.

 

Note: The page must be published to the production web server to make it live on the World Wide Web.
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Compare
Compare Overview
The Compare feature includes the ability to compare different versions of a page. The compare feature is
found in the Versions section of a page. Compare allows a user or reviewer (e.g., an approver) to easily
identify changes that have been made to a given page by comparing the newly proposed page with either
the page currently on the production server (the last published version of the page), to any prior published
versions, or to any version explicitly saved by the Save Version function. Comparing versions is also
supported by Multi-Target Publish and a version on a publish target can be selected, if Multi-Target Publish
is in use.

The document comparison of various versions provides mark-up of text, image, and asset changes with
color coding and strikethrough notations.

Versions Screen
The Compare feature is located on the Versions screen, which shows a list of versions of a page. Versions
can be accessed in either of two ways:

1. From the Pages list view, check out the page. Hover over Review in the page row and
choose Versions. 

2. Enter the Preview or Edit mode of a checked out page. Click the Versions button in the Page
Actions toolbar. 

Either method directs the user to the Versions screen where a comparison can be made. The Versions
screen includes the following features and functionality:

• Lists the number of versions of a page or file
• Filter
• Compare Current to Live
• Compare Current to a publish target
• Sort
• View the rendered page or source of a page of any version
• Compare the currently saved version to any previous version of a page with or without includes, or in

source view
• Revert

http://support.omniupdate.com/oucampus10/pages/review/revert.html
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Example of Versions Screen

Comparing with a Production Version
When comparing with the current version on the production server, either page or source view is available. If
comparing in page view, hide includes is also available.

1. From the Versions screen click the Compare Current to Live button. The comparison is shown for the
rendered page. If configured and available, a publish target may be selected by clicking the drop-down
arrow on the button.

2. If so desired, click Hide Includes to hide any include files that are part of the rendered page.

3. Additionally, if it is required to view a comparison of the source code, click Source to view a comparison
of the source code. If viewing the source, the includes are pulled in automatically.

Comparing with a Previous Version
When comparing with versions other than the live production version, a source code comparison is
rendered. This option pulls in the includes files and shows revisions in the code. It is useful for pages
rendered as ASP or when the compare is not being rendered due to the format of the include files.

1. From the Versions screen, hover over the menu bar for the page version and click Compare. The
Version Compare is displayed.
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2. When comparing the staging version with previous versions, the different versions can be scrolled
through or a version number can be entered with which to compare.

Examples and Legends
Production Page
The following table lists the mark-up types and color-coding for comparing to the live production page in
page view. For example, text that is shown in red strikethrough indicates text that was deleted. Green
underlined text indicates that the text was added. Blue text with a squiggly underline indicates text that
underwent a formatting change such as having applied bold or italics to the text.

Type of Change Color Style

Deletion Red Strikethrough

Addition Green Underlined

Formatting Change Blue Squiggly underline

 Example of Live Version Comparison
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Source and Other Versions
When comparing to the live production server version in source view or when comparing to any other
version the markup is slightly different as no blue markup is provided. Any addition of text or formatting
change is show in green (not underlined).

Type of Change Color Style

Deletion Red Strikethrough

Addition or Formatting Change Green Plain Text

Example of Source Comparison

Final Words
Approvers can use this feature when reviewing a page prior to publishing it. The approver (depending on the
page’s access settings) can then elect to publish the page, schedule it for publish, send it to another user for
review, decline to publish it but keep the changes, which then sends it back to the requester, or decline to
publish it and revert to the previous version. This also sends it back to the requester.

If the approver does not have publishing rights, only Send to User and Decline & Keep will be visible.
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Publish
Publish Overview
File, directories, or sites can be published from the staging server to the production server or an alternative
publish target, if configured. Once a page, directory or site is published is it available on the World Wide
Web. Only level 10 administrators can publish directories and sites. This topic discusses publishing a page
from a user's perspective. For more information about administrator publishing, see:

Publish Directories and Sites 

Pages can be published by all user levels. However, it is possible to restrict publishing permissions by
assigning an approver, and even overriding that restriction with a Publishers group. If, as a user, Send to
Approver is the only option available, then the page must be sent to an approver as part of the publishing
workflow.

Publishing a page is also a method to reuse content. For example, at the time of a page publish, an RSS
feed can be updated. Facebook, Twitter, and blog content can also be published. Page publish can include
publishing to multiple outputs and alternative publish targets.

Additionally, at the time of publish, various automated reviews of the page to check spelling, accessibility,
linking and standards validation can be configured by an administrator to automatically run.

Dependency Manager tracks when a page includes dependencies that have not yet been published. When
publishing a page an error message indicates that the page includes unpublished content that might result
in broken links or missing content. The unpublished content can include assets and unpublished pages.
From the Publish Option section, select the Include unpublished dependencies checkbox to publish the
unpublished content.

About Recycle, Delete, & Restore
Inherently, only administrators and Level 8 users can recycle and delete files, pages, directories, and
assets. The delete permissions for Level 8 include only the files and directories to which they have access.
Administrators can assign access rights for recycling and deleting files and pages to Level 1–7 users. By
default the recycle bin function is configured for a site, and this allows pages on the staging server to be
recycled rather than immediately and permanently deleted. When a page is recycled rather than deleted, it
can later be restored if necessary. When a page is recycled on the staging server, the published derivatives
are automatically deleted from production servers. Likewise, a file can also be solely deleted from the
production server or other publish target by navigating to the Production tab or tab for the publish target,
and deleting it. The recycle bin functionality does not extend to these servers. Once a file is deleted from
the production server or publish target, it cannot be restored. It can be re-published from the main file on
the staging server with any routine form of publishing, such as publish, site publish, directory publish, or
scheduled publish. Directories cannot be recycled on staging nor on a production server. Directories that
are deleted are immediately and permanently deleted. There is a multiple file recycle function. All or multiple
files within a directory can be selected with the checkbox and the recycle bin function for multiple files can
be selected. Then the directory can be deleted. Recycling files within a directory in this method enables the
ability to individual restore the files from the directory. Restoring a file is performed from the recycle bin.
From the recycle bin a file can be restored or permanently deleted, or the entire recycle bin can be emptied.
For more information:

Recycle and Delete

http://support.omniupdate.com/oucampus10/pages/publish/directory-site-publish.html
http://support.omniupdate.com/oucampus10/pages/file-options/recycle-bin.html
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Publishing a Page
Publishing a Page Overview
Pages and other content within OU Campus are edited on a staging server. They must be published in
order to be viewable on the World Wide Web. By default, all user levels can publish content, but this can be
restricted by an administrator with the use of access settings. If an approval workflow is in place for a site,
a user may see a Submit button rather than a Publish button. In this case, the user should send the page to
the approver or other user if applicable, for review and publishing.

Publishing a page or other content can be as simple and easy as clicking the Publish Now button. There are
quite a few other features related to publishing that may or may not be enabled for a site.

Publishing a page can be a method to reuse content. For example, at the time of a page publish,
an RSS feed can be updated with a new feed item, as well as posting content to Facebook, Twitter, and/or a
blog.

Page publish can also include publishing to multiple outputs and alternative publish targets, or can involve
scheduling a publish for the future.

Additionally, at the time of publish various qualitative reviews of a page such as to check the spelling, check
compliance to an accessibility standard, checking for broken links, and to validate to the W3 standard for
HTML can be configured by an administrator to run automatically before publish.

Binary file types also must be published to the production server if under management with the Binary
Management and Dependency Manager features.
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Publishing a Page
A page may be published in any of three ways:

1. A page can be published immediately after editing and saving the page by clicking the Publish button in
the page actions toolbar. The button is only shown if the user has publishing rights.

2. A checked-out page can be published by navigating to the Pages List view and hovering over Publish
on the page row, which is only shown if the user has publishing rights.

3. Multiple pages can be selected for simultaneous publish. Simply check the boxes in front of the pages to
be published, and click the Publish option at the top of the page list view.

Clicking the Publish button displays a publish dialog. Within this screen the following tools may be found:

• Final Check: This tab includes a set of checks that can be run manually by the user or can be set to
automatically run by the system administrator. 

• Output Selector: If more than one output is created by the template configuration (e.g., both an HTML
page and a CSV are created) and the alternate is a type on which the checks can be run, the selector
can be used.

http://support.omniupdate.com/oucampus10/pages/publish/finalcheck.html
http://support.omniupdate.com/oucampus10/pages/review/preview/preview-multi-output.html
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• Run All: Click to run all available checks on the selected output. See Final Check.
• Spell Check Language: The default language (as determined by the Locale setting) for the spell check

dictionary is shown, but a different dictionary can be selected by which to run the spell check against.
• Spelling: Checks the spelling on a page in the given language selected in the Spell Check Language

box. 
• Links: Checks for broken links on the page. Links may be broken due to unpublished dependencies. If

available, the Also Include Unpublished Dependencies checkbox can be selected to publish files that
have been linked to, but not yet published. See Dependency Manager.

• W3C Valid:Checks a page for valid HTML and XHTML markup, depending on the schema setting.
• Accessibility: Checks the accessibility of a page complies to the standard defined by an administrator

(i.e., WCAG, Section 508, Stanca Act, or BITV).
• Publish Target: If available, a publish target other than the production server may be selected.
• Also Include Unpublished Dependencies: This checkbox allows a user to publish all unpublished

dependencies for the page at the time of publish. When enabled, the Dependency Manager reports at
the time of page publish if there is dependent content that has not been published to the target server.
This includes content that is linked or referred to by the page that is being published. This prevents
broken links and images from occurring on the current page being published. This option only works
if Dependency Manager is enabled, dependency tags are being used on the page being published, and
one or more of the dependency tags in use refer to files that have not been published to the current
target.

• Version Description: This will allow a version description to be included in order to indicate what was
updated and why the page is being published. This can be used when choosing previous versions in
which to revert.

• Schedule: This tab allows for a scheduled publish, rather than an immediate publish, of the page. A
user can select the date and time of publish, and choose to repeat the publish according to a schedule if
desired. A user is also notified of publish, and can choose to be notified in the user's OU Campus Inbox
only or also to the user's external email if configured in the user's settings.

• Social Media: This tab provides options for the user to include a publish to Twitter or Facebook with the
page publish. A shortened URL for the page can be added by clicking the Add URL link beneath the
respective social media fields.

• Twitter: If one or more Twitter accounts have been configured, the system sends a tweet to the selected
Twitter accounts upon publish. A shortened URL can be added that directs to the published page.
Tweets may be up to 140 characters in length.

• Facebook: If one or more Facebook pages have been configured, the system sends a post to the
selected Facebook pages upon publish. A user may add a shortened URL that directs to the published
page. Posts may be up to 420 characters in length.

• Publish: Allows a user to publish the page. 

If a user does not have publishing rights, they will not be able to access the Publish dialog as no Publish
item will be available.

Selecting a Publish Target
If Multi-Target Publish has been enabled for the site and alternative publish targets defined, users with the
proper access rights can publish to it. The defined publish targets are available in a drop-down menu. When
within the Pages view of the site, the available servers, including the staging, production, and additional
publish targets, are shown in tab view. 

http://support.omniupdate.com/oucampus10/pages/publish/finalcheck.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/spell-check.html
http://support.omniupdate.com/oucampus10/setup/account/optional-features/dependency-manager/index.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/w3c-valid.html
http://support.omniupdate.com/oucampus10/pages/review/page-check/accessibility-check.html
http://support.omniupdate.com/oucampus10/interface/content/servers.html
http://support.omniupdate.com/oucampus10/setup/account/optional-features/dependency-manager/index.html
http://support.omniupdate.com/oucampus10/pages/publish/schedule.html
http://support.omniupdate.com/oucampus10/social-media/index.html
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Server Options in Content > Pages

For more information regarding Multi-Target Publish, please see:

Publish Targets

 Viewing the Publish Notes
Once a file has been published, the message input before the file is published can be viewed within the
versioning system. To view the notes, check out a page from Content > Pages. Hover over Review on
the page row and choose Versions. This will present a log of the publishes and backups, including any
messages.

http://support.omniupdate.com/oucampus10/setup/sites/site-settings/publish-targets.html
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Final Check
Final Check Overview
Final Check gives a content contributor the capability to perform a series of quality assurance tests on a
page before publishing. These include spell checking, link checking, W3C validation, and/or accessibility
compliance. An administrator can configure the options, if any, to auto-run when an OU Campus user
publishes a page. Even if Final Check is not configured to run automatically at the time of publish, the site
may configured so that a user may manually run any enabled checks.

The available Final Check options are based on the activated Page Check options. For more information
about Page Check and available options, see:

Page Check

Running Final Check
Final Check can be configured in one of two ways:

• To be forced to be run all the checks or a selective combination of page checks at the time of page
publish

• To allow users to choose which page checks, if any, to run at the time of page publish

If Final Check is configured to force Final Check, any time a page is published by clicking on the
Publish button from the page preview or edit view, or the Publish menu for the page from the Pages list
view, any selected Final Check options will run. They must run to completion prior to the Publish button
at the bottom of the screen being available to complete the publication process. Once the check has
completed, click any of the indicated errors to view them. It is strongly advised that the errors be resolved
prior to publishing the page. Note that the identification of errors, warnings, or problems does not prevent
the page from being published.

If Final Check is not configured to run automatically, click Run All to run all checks, or click any of the
enabled checks to selectively run checks.

http://support.omniupdate.com/oucampus10/pages/review/page-check/index.html
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Example of Spell Check Errors

With Multi-Target Publish
If additional publish targets are enabled for the site, they can be selected at the time of publish.
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Schedule
Schedule Overview
When users want to publish content, but wish to do so at a later date, they can utilize the Scheduled Publish
tool. A scheduled publish can only be canceled or modified by the user who set the schedule or a Level 9
or 10 administrator. If a new RSS item has been added to a page, but not yet published, the RSS item is
added to the feed and the feed is rebuilt with a new page publish. The Schedule Publish tab is part of the
Publish dialog, which can be accessed from the Pages list view by selecting Pages > Content from the
global navigation bar.

Additionally, selecting a publish can be performed from any screen that contains the Page Actions toolbar.

Schedule Tab
When users select the Schedule tab of the Publish dialog, the following elements are displayed:

• Date: The target date the user wants the page to publish on.
• Time: The time at which the scheduled publish will take place.
• Repeat Every: Allows users to repeat the publish by specific amounts of time using the text field and

drop-down selector.
• Subject: Optionally, users can send an external email in addition to the internal OU Campus message.

This field lets users add a subject line to that email.
• Message: Allows users to include a brief message about the publish in an external email.
• Also Email Me: If selected, the option sends an external email to user in addition to the internal OU

Campus message.
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After a Scheduled Publish has been performed, the content's status will change in the Pages list view.
A green calendar icon indicates that the page is checked out to the current user because the user has
scheduled a publish to occur. Other users' scheduled publishes will appear as red calendars.
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Performing a Scheduled Publish
1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

2. Hover over the target item's row and select Schedule from the Publish menu. Additionally, navigating
to a view that displays the Page Actions toolbar and selecting Schedule from the drop-down menu on the
Publish button will accomplish this.

3. Click in the Date text field to display a calendar widget and select a date. Users can scroll through the
months of the calendar using the arrows at the top of the calendar.

4. Click in the Time text field to display a time selector and set the target date for the publish.
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5. In the Notification section, a checkbox may be selected to Also Email Me. This sets an optional
notification email that can be sent when the page is published. If selected, fill out the fields in the
Notification section.

7. If preferred, select the Final Check tab and run any tests necessary before publishing.

8. Click Schedule.

When the page is published, the notification email is sent through workflow, and if the option checkbox was
utilized, through external email.

Removing a Scheduled Publish
A Scheduled Publish can also be removed from content. If a user attempts to immediately publish content
that is already scheduled for publishing at a later date, they will be unable to perform this action until the
Scheduled Publish assignment is removed. To remove a Scheduled Publish:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

1. Click the green calendar icon on the target item's row to display the Remove Publish Schedule dialog.

2. Click the yellow Remove Schedule button to cancel the scheduled publish. 

To remove the Scheduled Publish using the Page Actions toolbar:
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1. Preview the scheduled page, or enter into the pages Edit mode through DirectEdit or by using the My
Current Pages gadget. 

2. Click the Unschedule Publish button in the Page Actions Toolbar. A dialog will appear.

3. Confirm by clicking Remove Schedule. 

When the page is published, the notification email is sent through workflow, and if the option checkbox was
utilized, through external email.
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Submit for Approval
Submit for Approval Overview
If an approval workflow is in place, and users, content areas, or a content type have had an approver
assigned, then a user may have to send the content for approval rather than being able to publish directly.
Content must be checked out before it can be submitted for approval.

Instead of a Publish item on-screen, they will see a Submit button or Submit for Approval item on the
Publish menu.

Users Level 4 and greater that have not otherwise had an approver assigned, also have this functionality
available as an option and may choose to use the Submit for Approval feature to send the content to
another user.

Sending the page to an approver transfers the checked-out status from the current user to the approver to
whom the page is sent. The sent content is shown in both the user's and the approver's Workflow with a
status of Pending Approval. Content in an approval workflow is also shown on the Pending Approval report.

The Submit for Approval dialog includes the following items:

• To: Users select an approver from the drop-down to send the content for review. If the approver is
enforced, then the drop-down is unavailable and the content must be sent to the enforced approver.

• Subject: Required. A brief subject used to help identify the file for review.
• Message: Optional. Users enter a brief description in the text field to help approvers identify the changes

that have been made.
• Send Copy to Email: Sends an email to the approver's external email address in addition to the internal

OU Campus message received in the approver's workflow Inbox.
• Submit Button: Click to send the content to the approver.
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Sending for Approval
Both pages and binary files can utilize the approval workflow.

1. Navigate to the Pages list view by selecting Content > Pages from global navigation bar. Additionally,
expanding the File Navigation sidebar displays a list of the available pages.

2. Select a page from the Pages list view and hover over the row. Choose Submit For Approval from the
Publish menu.
Additionally, clicking the linked file name from the File Navigation sidebar will display a view that
includes the Page Actions toolbar. From the toolbar, click the arrow on the Publish button to reveal
additional publishing options including Submit For Approval.

3. Select the user from the drop-down next to the To field. If an approver has been enforced, the To field
is auto-populated, and there will not be a drop-down available.

4. Fill out the necessary text fields.
5. Optionally, select Send External Email to allow the request for review to be sent to the user’s external

email address. This allows the user to receive an indication that action is to be completed without
having to log into OU Campus. Clearing this option will only send the message through the OU Campus
system.

6. Click Submit.

For more information about approving content:

Approving

http://support.omniupdate.com/oucampus10/pages/review/approving.html
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New Content
New Content Overview
Content can created and managed within the Pages list view of the CMS. By navigating to Content >
Pages, a user with the proper authority may create new pages, sections, and folders. The system is
configured with templates, which are utilized to create new sections and pages. These templates allow for
the pages to be configured uniformly and have a consistent look and feel. The available templates depend
upon the structure created by the administrators. For more information about setting up templates, please
see: 

Templates

Templates available for creating new content is dependent upon the structure created by the administrator.
Templates are specific to the institution, and examples given may very from new page to new page, as well
as from institution to institution. Note that the template choices below are examples and may not be the
same template options offered by the institution.

Creating New Content
New pages and directories can be created by clicking the New button or the drop-down indicator next to
New from within the folder structure. 

Similar options are available between clicking the New button and clicking the drop-down indicator. Not all
options may be available on both menu views. Note that the option to create a folder is unavailable when
the New button is used, and that the user is navigated away from the directory structure to a new screen.

Example of New Content Options from Drop-Down

http://support.omniupdate.com/oucampus10/setup/templates/index.html
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Example of Select New Content Screen

The options available for creating new content are:
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1. Create a New Folder. Folders are for binary files and are not the same as creating a new directory. A
folder can be created to contain binary files, such as images and PDFs. A folder can only be created
from the drop-down indicator, and not from clicking the New button.

2. Create a New Section. The New Section option creates a new content-based directory. 
The new section template will contain all of the necessary files to make the pages within the new
directory render correctly.

When creating a new section, navigate to the parent directory where the new section will be contained.
If New Section does not appear, contact the administrator. 

3. Create a New Page. A new page can be created by clicking on the appropriate template for the type
of page. Note that administrators can restrict the type of templates available for the directory, and that
users may not have a choice in template type.
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Creating a New Page
Creating a New Page Overview
A new page can be created from existing templates within the OU Campus system by accessing the Pages
list view. The Pages list view can be accessed by selecting Content > Pages from the global navigation
bar. Pages should be created from within the appropriate directory to avoid needing to move pages and
accidentally creating broken links. Not all users have the authority to create new pages, and users with
authority to create new pages may have restricted access to the type of template that may be used. Users
have access to the following screens during the new page creation process:

• Select New Content: Allows users to select a template from the local templates directory in the
account. 

• New (Template Name) Page: Users customize basic metadata information about the new page from
this screen.

New Page Creation Options
A new page can be created from the Pages list view by using the New button.

Users can additionally click the drop-down indicator on the New button to display the available templates.
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The New button and the drop-down indicator can both be used to create a new page, but reveal different
styles of menu. The drop-down indicator reveals a menu within the directory structure. The New button
navigates away from the directory structure to a new screen.

Select New Content Screen
When users either click the New button or use the drop-down menu on the New button, the Select New
Content screen is displayed. The templates available on this screen will vary depending on site access
settings as well as user access settings. Users click one of the Template Icons to open a dialog for editing
the new page properties using the selected template. The elements displayed include:

• Template Icon: Provides users a thumbnail icon, usually depicting the functionality of the template
associated with the image.

• Template Name: Provides the TCF file name for the template as it appears in the OU Campus system.

New (Template Name) Page Screen
After users select the template to use for the new page creation process, a dialog displays. The options
available on this screen are directly dependent on the options defined in the template's XSL and therefore
will vary depending on which template is selected. Users fill out all necessary parameters in this dialog to
create a basic page with no content. Users utilize the WYSIWYG Editor to create custom content to include
in the page.
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Creating a New Page
To create a new page in the OU Campus system:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Click the New button, or use the drop-down menu. 
3. Select the type of page to be created.
4. Fill out the New Page information in the displayed dialog.
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5. When the information is completed, click Create.
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Upload and Edit Image
Upload and Edit Image Overview
An image can be edited and uploaded from the Upload To dialog within the Pages list view of OU Campus.

Selecting and Uploading the Image
1. From the Pages list view, click the Upload icon.

2. For Upload Type, choose Upload and Edit Image.

3. Select the image file from the local computer for uploading and editing.

4. This displays the Edit Image panel with the image.
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5. After utilizing any necessary editing functionality, click Upload to upload the image.

Editing the Image
The following functionality is available on the Tools menu:

• Resize
• Crop
• Rotate
• Zoom
• Undo
• Redo



OU Campus Upload and Edit Image Page 164 of 188

Resize
The Resize tool includes the ability to specify a new width and height for an image to upload. The original
ratio for the dimensions of the width and height for can be kept intact by selecting the Preserver Ratio
checkbox.

 

Crop (Custom)
The Crop tool can be used to reduce the dimensions of the image by either selecting a ratio or by
determining a custom crop size by manipulating the crop box by dragging the crop handles located on the
edges of the crop box.
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Rotate
The Rotate tool rotates the image (edited and unedited) 45 degrees in a clockwise direction with each click.
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Zoom
The Zoom tool can be used to manually enter a percentage of the original image size to be displayed in the
Edit Image panel for editing. The plus and minus magnifying glass buttons may also be used to increase or
decrease the viewing size.

The Original button reverts the image to the original size.

The Zoom to Fit button resizes the image to fit into the panel for viewing.

Undo/Redo
The Undo and Redo functionality is available after performing another editing function.
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Creating Assets
Creating Assets Overview
A user can create assets from the Assets list view, which can be accessed by selecting Content > Assets
from the global navigation bar. The basic steps for creating an asset are the same for all assets types.
Depending upon the asset type being created the available fields and options vary. By default, user levels
4 and above can create assets. Click the New button to create a new asset. The following panels are
available:

• Asset Info: Configures basic metadata properties.
• Access Settings: Allows for the initial assignments of groups to the access settings for editing and using

the asset. Approver/workflow access settings can be configured after creation.
• Asset Content: Allows users to create the content within the asset.

LDP is an optional set of features in OU Campus that require specific configuration by an administrator.
Please contact the university’s designated OmniUpdate Sales Director for details. The Forms and Image
Gallery assets are not shown unless Live Delivery Platform has been purchased and activated both at the
account level and the site level. 

Asset Info Panel
The Asset Info panel allows users to configure basic metadata properties of an asset. The following are
displayed in the Asset Info panel:

• Asset Name: Friendly name that will be displayed through the whole system.
• Description: The description can also be useful as it is shown when selecting an assets from the Asset

Browser when hovering over an asset.
• Tags: Tags can be added during asset creation or editing. Tags can be utilized by users to filter a list of

assets.
• Lock to Site: Select the checkbox to disallow use of the asset outside of the site. Forms assets are

locked to site by default. In other words, assets are available to all sites within an account. If the asset
should only be available to the site in which it was created, then select this checkbox.

Access Settings Panel
The Access Settings panel allows users to configure the access settings for editing and using the asset. The
Access Settings panel contains the following items:

• Access Group: Assigns an access group to the asset. Everyone, the default, indicates that every user
within the account can edit the asset from the Access screen.

• Available To: Assigns an access group specific to who can use the asset. Everyone, the default,
indicates that every user within the account can insert the asset on to a page.
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After the asset has been saved, the additional settings include Approver, Enforce Approver, and Bypass
Approval.

Asset Content Panel
The Asset Content panel is available for Web Content Assets, Source Code Assets, and Text Assets, and
allows users to create the actual content of the asset. The available  functionality of this panel depends
upon asset type. Image Galleries and Forms do not have this panel displayed.

Creating a New Asset
To create a new asset in the account:

1. Navigate to the Assets list view by selecting Content > Assets from the global navigation bar.

2. Click the New button.

3. Select the asset type from the menu.
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4. Configure the necessary settings.

5. Click Create.

6. Publish the asset. An asset must be published to the production server or publish target to update
content on pages. An asset may be inserted on a page without publishing, but the content will not update
the page on the web server.
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Inserting Assets
Inserting Assets Overview
In order to insert an asset into a page or editable region, it must first be created within a site in the OU
Campus system. For more information about creating assets:

Creating Assets

Once assets have created, content contributors can utilize assets. Assets are commonly inserted by one of
the following methods:

• Using the WYSIWYG Editor
• Using an Asset only region
• Using the Source Editor

Inserting an Asset with the WYSIWYG Editor
Most often, an asset will be available to insert on a page while editing in the WYSIWYG Editor. Content
editing might also be configured so that when clicking on an editable region button, the user is only
presented with an asset chooser. Once a page has subscribed to the asset, any changes in the asset
will update the page and republish it. The republishing of pages subscribed to assets can be throttled by
administrators with the configuration of the publish threshold setting.

1. While in the WYSIWYG Editor, place the cursor where the asset will be entered.
2. Then find and click on the Insert Asset icon in the toolbar.

3. From the Asset Browser, choose the asset from the list of available assets. Optionally, a user can
filter the list by tag, type, or site. Assets from all sites within an account are shown, unless otherwise
restricted except for Managed Form Assets, which are site specific, are also only shown in the site in
which they were created.

http://support.omniupdate.com/oucampus10/reusable-content/assets/creating-assets.html
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4. Click on Select Asset.

The asset will be entered into the page where the cursor was placed. If the asset is a Text Only Asset, or a
Web Content Asset with no block level HTML code (such as p or div tags), the asset will preview with the
content inside of a wrapper.

If the asset is a Web Content Asset with block level HTML code, a Source Code Asset, an Image Gallery
Asset, or a Managed Form Asset, it cannot be previewed in the WYSIWYG Editor, but it will still have a
wrapper. Note that even though the asset is not displayed in the WYSIWYG Editor, most will still render in
the page preview. Source Code Assets will not always render with preview.

To delete an asset from a page in the WYSIWYG Editor, click anywhere on the asset wrapping and press
the Delete key.

Inserting an Asset Only Region
An administrator may also create a template file that displays an editable region which forces users to use
an asset chooser.

1. Click on Choose an Asset when creating a new page or in the MultiEdit screen, or simply the Edit
button in an editable region.

2. Search for the desired asset using the filter options. Assets from all sites will appear, except for
Managed Form Assets, which are site specific.

3. Select the desired asset.
4. Click Select.
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Inserting an Asset with the Source Editor
A user can add an asset to a page or editable region using multiple methods including the Source Editor. It
is important to remember that only Level 10 and Level 9 administrators have access to the Source Editor in
the OU Campus system. However, lower level users can have access to the Source Editor as well as long
as an administrator has enabled this functionality for the user's account in their permission settings.

1. Navigate to the pages list view by selecting Content > Pages from the global navigation bar. Hover
over the row for the target page and select Edit from the list of available actions.

2. While in the Source Editor, place the cursor where the asset will be entered. Then click Insert from the
available toolbar.

3. After clicking the icon, the Insert Asset dialog is displayed.

The Insert Asset dialog contains a list of the available assets along with a preview of the asset's
content. The available list can be filtered by tag, type, or site.

4. Select the asset to be used.
5. Click Insert. The asset tag is entered into the source code where the cursor was placed.

Assets in source code follow the syntax {{a:###}}, where the ### denotes the asset number.  If an
asset number that does not exist is entered, the asset does not render.
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Dashboard
The OU Campus Dashboard provides a location within the CMS where each individual can access
user-specific messaging and gadgets. The Dashboard is the default log in location from the standard
OU Campus Login screen when not utilizing DirectEdit. Quick links are provided to the Workflow and
Inbox screens of Mailbox, which are also accessible from the Dashboard menu. The Dashboard can be
customized by each individual user by choosing which gadgets to show or hide in the view. The user can
also modify the appearance by dragging a gadget to reorder the view. A Level 10 administrator can add
gadgets to the system, and then make them available with group assignment. 

Image

Example Dashboard with Gadgets (caption)
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The available features and functionality of the Dashboard are as follows.

User Avatar or Gravatar, and User Name: The link provides access to the currently logged-in user’s
settings for viewing and modification. For more information:

Settings

Workflow
The Workflow list view shows content that a user has been sent for approval or content that a user has sent
for approval and are separate from other messages, which can be viewed in the Inbox and Sent. Content
within an approvals process can be tracked using this screen. For more information:

Workflow

Inbox
Inbox displays messages from other users as well as automated messages associated with scheduled
actions, such as a notification of scheduled publish or notification of page expiration. The Inbox includes a
linked list of messages and the functionality to compose a message. For more information:

Inbox

Configure Dashboard
Once specific Dashboard gadgets have been configured to be available for a group of users, members of
the group can choose which gadgets to show on the main content area. The Configure Dashboard feature
can be used by each individual user to choose which gadgets to show in the main content area. For more
information:

Configure Dashboard

Frequently displayed gadgets include an activity feed of recent site activity, the system inbox for messaging
and notifications, a list of pages that are currently checked out by the user, and site analytics. For more
information:

Gadgets

Dashboard gadget can be reordered by clicking the gray title bar and dragging to the new location.

http://support.omniupdate.com/oucampus10/interface/settings.html
http://support.omniupdate.com/oucampus10/interface/dashboard/workflow.html
http://support.omniupdate.com/oucampus10/interface/dashboard/inbox.html
http://support.omniupdate.com/oucampus10/interface/dashboard/configure-dashboard.html
http://support.omniupdate.com/oucampus10/interface/gadgets/index.html
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Workflow
Workflow Overview
Workflow is a component of Mailbox that facilitates the tracking of content that has been sent for review
through the approval process. Workflow is specific to the currently logged in user — content that the user
has submitted to another user, or received from another user, is shown in this list view. Additionally, content
that was once in workflow for the user, but had an action performed, such as the content was approved and
published, declined, or cancelled, is also shown in this view.

When access settings have been configured by an administrator, it may be required for a user to use the
Submit button to send content to an approver in order for the content to be published. When this is the
case, the Publish button is replaced by the Submit button. A message can be composed to accompany the
content that is sent. Both a link to the content and a status icon that links to the message are shown in the
Workflow list view.
General messages sent to the user's account are separated from Workflow files and are available in the
Inbox. 

Level 9 and Level 10 administrators may view the Pending Approvals report to view all content in workflow.

Workflow can be found from the dashboard, either by clicking the Workflow link on the Dashboard screen, or
by clicking Workflow in the drop-down Dashboard menu.

Workflow in Dashboard Menu

Workflow on Dashboard
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Workflow Screen
The Workflow screen includes the following features and functionality:

• Shows the number of items in the Workflow
• Includes the ability to filter based on the user who sent the content or the approver
• Can use multi-select in order to delete multiple workflow messages with the same action
• Can use the selection checkboxes to select a message to view or delete
• The list can be sorted by From, Approver, File, Status, or Date
• Click the linked file name to view the Preview of the content
• Shows the status
• Shows the date and time that the content was sent for approval

Example of the Workflow Screen

File
The approver can click the linked file name to preview the content. Content that is sent to an approver is
automatically checked out to that user and the user can perform various page or file actions on the content,
including decline and revert. For example if the content is an image, the Image Editor is automatically
previewed. If the content is a page, the preview of the page is shown. Please note that Level 0 Reviewers
cannot edit files.

 

Status
A status icon is shown in the Status column for each content item. Content listed in Workflow can be
previewed by any user, but only the user to whom the content was sent has the file checked out and can
perform other actions upon it. Clicking a status icons shows the Workflow Message.

Status Icon Description

Pending Approval (by another user)
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Status Icon Description

Pending Approval (by the current user)

Approved and Published

Declined

Cancelled from Workflow

View
When content is sent for approval, the sender can attach a message. This is associated with the item in
Workflow as a Workflow Message. This can be viewed by performing one of the following actions:

• Hovering over the file row and clicking on the View option
• Clicking the Status icon
• Selecting the checkbox next to the item and clicking View

From within the message, the following features and functionality are available: 

• Clicking the linked file to preview the content sent for approval
• Viewing the workflow details, including the site from which the content originated, the status, the date

of the latest action indicated by status (e.g., if the content has only been sent for approval but not
approved, this shows the sent date, once published this shows the publish date), and who sent the
content and the approver. This also shows the messages details: I.e., the date and time the message
was sent, the subject, and the message (if any).

• Deleting the message
• Replying to the message
• Navigate back to Workflow

Reply
A message in Workflow can be replied to by clicking the Reply button in the message. The Reply dialog
is shown. Additional users or groups can be added to the message, the subject can be changed, and a
message can be added. Optionally, a copy of the message can be sent by email in addition to the internal
OU Campus message. 
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Click Send to send the message to the selected users or groups and the user will be returned to the original
Workflow message. Clicking Cancel returns the user to the original Workflow message. The message is
sent to each user's inbox.

Delete
The workflow item can be deleted with one of the following actions:

• Hovering over the file row and clicking Delete
• Clicking the Status icon and from the Workflow Message view, clicking Delete
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Inbox
Inbox Overview
The Mailbox within the OU Campus CMS includes an inbox, sent box, the ability to compose a message,
and the system workflow. The messaging system is internal to OU Campus and allows users of the system
to attach messages to pages being sent through workflow, such as to an approver. Additionally, users
can send a message directly without associating it with a page, review messages previously sent to them,
forward messages, and review message they have sent to others. Some messages may also have a copy
sent from the CMS to an external email.

Inbox
The Inbox is similar to a standard email inbox. General messages sent to a user's account can be read,
replied to, and forwarded. New messages can be composed.

The Inbox can be viewed from the Dashboard by using the Inbox gadget. The Inbox may also be viewed
and messages composed by entering the Inbox from the Dashboard menu or the link to the Inbox from the
Dashboard itself. 

Example of Inbox Screen
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Example of Inbox Gadget on the Dashboard

Viewing, Replying to, and Deleting Messages
The Inbox is used to list all internal messages. To view a message within the Inbox screen, hover over the
message row and click View, or click the hyperlinked message subject. From the Gadget, click anywhere on
the desired message to enter the message view in the Inbox screen.

Use the blue Reply button to reply to the message, or use the drop-down indicator next to the Reply button
to forward the message to another user. A user can return to the Inbox without responding to or deleting the
message by clicking the Back to Inbox button. 
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A message may be deleted by using the red Delete button inside of the message, or by hovering over the
message row in the Inbox list view and clicking Delete. Multiple messages may be deleted by selecting the
checkbox next to each message and clicking the Delete icon that appears in the top row. Messages may
also be selected in this way to mark unread messages as read messages by clicking Mark Unread As Read.

Message Status
A message viewed in the Inbox gadget will have a blue New notification next to it, indicating that the
message is new and is unread. Messages that are new in the inbox screen will appear in bold. 

Messages that have been read will not have the notification next to it in the Inbox Gadget, and will no longer
appear in bold in the inbox screen.
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Gadgets
Gadgets Overview
All user levels have the ability to choose which available gadgets to show on the Dashboard as well as
on the Gadgets sidebar since these are configured separately.  Dashboard gadgets can be chosen to be
shown or not by clicking the Configure Dashboard link on the main content area of the Dashboard. The
Gadgets sidebar includes the Choose Gadgets button so that a user can choose which sidebar gadgets to
show for the sidebar.

Gadget Configuration
Access for gadgets of both types can be enabled by a Level 10 administrator from Setup > Gadgets. The
gadgets management area allows for the administrator to enable access by assigning a group to a gadget,
the members of which will have the ability to choose to show gadgets on the main content area as well as
to choose which gadget to show on Gadgets sidebar. In addition to being able to assign gadget access, an
administrator can create new gadgets and configure gadget-specific properties. For more information:

Gadgets Setup

Dashboard Gadgets
Frequently displayed gadgets include system gadgets that provide the functionality for an activity feed
of recent site activity, the system inbox for messaging and notifications, a list of pages that are currently
checked out by the user, and site analytics. These provide the user a thumbnail view of content, messaging,
and the ability to navigate to the content items. For example, the system gadgets illustrated in the
screenshot below are as follows:

• My Current Pages: Shows the content checked out by the current user and the date/time stamp that the
content, which can be a page, asset, or file, was checked out. Within this gadget, the pages are linked
and can be clicked to for editing or approving. The light bulb icon indicates the page is checked out and
clicking the icon checks the page back in.

• Activity: Activity shows content with recently performed actions such as a scheduled publish, expire, or
upload.

• Inbox: Provides a scrollable list of recently received messages.
• Site Analytics:

http://support.omniupdate.com/oucampus10/setup/gadgets/index.html
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Configuring the Dashboard
The Configure Dashboard link can be used to choose which gadgets to display on the Dashboard. Every
user level has access to this functionality.

1. Click Configure Dashboard. This displays the Choose Dashboard Gadgets modal to view the gadgets
available to the user.

• A gadget with a checkmark indicates it is being shown on the Dashboard.
• A gadget without a checkmark indicates it is not being shown on the Dashboard.

2. Click the gadget box to either select or deselect the gadgets to show on the Dashboard.
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Gadgets Sidebar
The Gadgets sidebar is a global element and can be shown or hidden by the user. The sidebar exemplifies
responsive design as the sidebar also automatically collapses or expands when a browser is resized. The
Gadgets sidebar can be expanded by clicking on the Show Gadgets button at the top right of the screen.

Once the Gadgets sidebar has been expanded additional functionality is available; including the ability to
choose which gadgets to show, to expand all, and to expand and collapse specific gadgets.
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When the Gadgets sidebar is expanded each individual gadget can be expanded and used according to its
functionality. The utilities that are available on the sidebar are dependent upon the implementation of the
site and can be configured by a Level 10 administrator.

Expanded View

Gadget Sidebar Icon Reference

Icon Name Description

Show Gadgets Click the Gadgets icon to show
the sidebar.

Choose Gadget Click to display the Choose
Sidebar Gadgets modal from
where it can be determined
which gadgets to show on the
sidebar.

Hide Gadgets Click the arrow to hide the
sidebar.

Expand All Click to expand or collapse all
gadgets.

Expand a Gadget Click to expand the view of the
gadget on the sidebar.

Collapse a Gadget Click to collapse the view of the
gadget on the sidebar.
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Icon Name Description

Launch Modal Click to view a gadget that is
displayed in a modal.

The Gadgets sidebar may include the following system gadgets by default:

• DM Tag Info: Search functionality for dependency manager tag that reports information about the tag.
Valid search syntax is shown below the field.

• My Current Pages: Shows the content checked out by the current user and the date/time stamp that the
content, which can be a page, asset, or file, was checked out. Within this gadget, the pages are linked
and can be clicked to for editing or approving. The light bulb icon indicates the page is checked out and
clicking the icon checks the page back in.

• Notepad: Allows for taking notes. Notes can be shared among users.
• Activity: Activity shows content with recently performed actions such as a scheduled publish, expire, or

upload.
• Images: Drag and drop images from any folder into edit views.
• Page Analytics: Displays analytics data about the site. This gadget is available by default on the

Dashboard.
• Page Info: Displays information about the file currently being viewed or edited.
• Quick Tasks: Provides one-click shortcuts for frequently performed tasks in OU Campus.
• Snippets: Drag and drop any snippet into an edit view.
• YouTube: Drag and drop videos from YouTube into edit views. This gadget requires a YouTube account

Choosing Sidebar Gadgets
The Choose Gadgets button can be used by each individual user to choose which gadgets to display on the
Gadgets sidebar.

1. Click the Choose Gadgets icon 

to view the available gadgets.

• A gadget with a green checkmark and green background indicates it is being shown on the sidebar.
• A gadget without a checkmark indicates it is not being shown on the sidebar.

2. Click anywhere within the gadget box to either select or deselect the gadgets that are shown on the
sidebar.
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